## Contents

**Working with IFC** ........................................... 5  
IFC File Types Supported by ARCHICAD ................................................................. 7  
ARCHICAD Classifications and Categories in IFC ....................................................... 8  
Export IFC Model from ARCHICAD ............................................................................. 11  
Import IFC Model to ARCHICAD ................................................................................. 15  
Open IFC Model .......................................................................................................... 17  
Merge IFC Project ......................................................................................................... 19  
Hotlink IFC File .......................................................................................................... 25  
Detect IFC Model Changes .......................................................................................... 29  
Update with IFC Model ............................................................................................... 35  
IFIC Project Manager ................................................................................................. 38  
  * Functions of the IFC Project Manager .................................................................. 39  
  * Navigating in the IFC Project Manager: Tree Structure ...................................... 40  
  * Navigating in IFC Project Manager: Attributes and Properties ......................... 46  
  * Assign or Edit IFC Property/Attribute Values ...................................................... 49  
  * Create New, Custom IFC Property ....................................................................... 52  
  * Create New Classification Reference .................................................................... 56  
  * Apply Predefined Rules ......................................................................................... 58  
  * Using Assignments in IFC Project Manager .......................................................... 61  
  * Using Type Products in IFC Project Manager ....................................................... 71  
Manage IFC Data at Element Level ............................................................................. 78  
IFIC Local Preferences ............................................................................................... 80  
Define Element Criteria using IFC Data ..................................................................... 81  
IFIC Translators: Overview ......................................................................................... 86  
Translators for Import (Detailed Settings) .................................................................. 94  
  * Model Filter for IFC Import ................................................................................ 97  
  * Type Mapping for IFC Import ............................................................................. 99  
  * Property Mapping for IFC Import ...................................................................... 101  
    Using the Mapping Table ...................................................................................... 105  
    Assigning Property Values in ARCHICAD (Based on IFC Property Mapping) .... 108  
  * Geometry Conversion for IFC Import .................................................................. 114  
  * Layer Conversion for IFC Import ........................................................................ 117  
  * Material and Surface Conversion ........................................................................ 121  
Translators for Export (Detailed Settings) .................................................................. 124  
  * Model Filter for IFC Export ................................................................................ 129
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type Mapping for IFC Export</td>
<td>132</td>
</tr>
<tr>
<td>How to Fix Error Warnings in the Type Mapping Dialog</td>
<td>139</td>
</tr>
<tr>
<td>Geometry Conversion for IFC Export</td>
<td>146</td>
</tr>
<tr>
<td>Property Mapping for IFC Export</td>
<td>156</td>
</tr>
<tr>
<td>How to create a Mapping Rule</td>
<td>162</td>
</tr>
<tr>
<td>Examples of Property Mapping Rules</td>
<td>165</td>
</tr>
<tr>
<td>Data Conversion for IFC Export</td>
<td>171</td>
</tr>
<tr>
<td>IFC Global Unique Identifier Attribute (GlobalId)</td>
<td>176</td>
</tr>
<tr>
<td>Unit Conversion for IFC Export</td>
<td>177</td>
</tr>
<tr>
<td>Filter Model at Import (Secondary Filter)</td>
<td>178</td>
</tr>
<tr>
<td>Filter Model at Export</td>
<td>181</td>
</tr>
<tr>
<td>Appendix: IFC Terms and Concepts</td>
<td>183</td>
</tr>
<tr>
<td>Model View Definitions</td>
<td>183</td>
</tr>
<tr>
<td>IFC Data Types</td>
<td>186</td>
</tr>
<tr>
<td>Appendix: IFC Data Mapping in ARCHICAD</td>
<td>195</td>
</tr>
<tr>
<td>Predefined Property Mapping (Export ARCHICAD to IFC)</td>
<td>195</td>
</tr>
<tr>
<td>Built-in IFC Type Mapping for ARCHICAD</td>
<td>201</td>
</tr>
<tr>
<td>Data Types for Properties in IFC and ARCHICAD</td>
<td>208</td>
</tr>
<tr>
<td>Index</td>
<td>209</td>
</tr>
</tbody>
</table>
Working with IFC

IFC (Industry Foundation Classes) is an open, neutral data exchange format. It is optimized for OPEN BIM- and model-based interoperability among disciplines, primarily in the AEC industry.

BIM, or “Building Information Modeling,” is one of the biggest advances in the building industry’s working methods since the introduction of CAD software. BIM is not synonymous with 3D projects. Three-dimensional geometric representation is only one part of the digital deliverables. A project includes non-graphical information, such as calculations, that are used in surveying, facility management and energy calculation. A prerequisite for a successful BIM project is that intelligent information can be exchanged between different software and even operating systems, throughout the stages of the building process. This interoperability demands a neutral file format with an open standard that supports different systems. IFC is such a system, enabling us to synchronize building models between the disciplines much more easily.

The IFC format is used for the efficient import and export of 3D elements and related non-geometric data, regardless of the application used to create the model. The IFC format is ISO-certified and can be integrated into any existing quality assurance policies your office may have. IFC is developed in part by buildingSMART (formerly the IAI - the International Alliance for Interoperability).

GRAPHISOFT has played an active role within the buildingSMART organization since 1996 and supports the IFC standard. Through IFC, ARCHICAD can communicate with other disciplines within the context of the building model. The building model can be exported back to literally hundreds of other systems that support IFC.

The list of registered IFC supporter applications (by functional category/design disciplines) is available here.

ARCHICAD supports the import and export of both IFC2x3 and IFC4 versions. IFC data are managed according to the latest worldwide-certified IFC standard, IFC2x3 TC1 (Technical Corrigendum 1).

For more information, see the buildingSMART website.

This chapter provides an insight into the IFC standard and how it works in ARCHICAD.

Related Topics

IFC File Types Supported by ARCHICAD
ARCHICAD Classifications and Categories in IFC
Export IFC Model from ARCHICAD
Import IFC Model to ARCHICAD
Hotlink IFC File
Detect IFC Model Changes
Update with IFC Model
IFC Project Manager
Manage IFC Data at Element Level
IFC Local Preferences
Define Element Criteria using IFC Data
IFC Translators: Overview
Translators for Import (Detailed Settings)
Translators for Export (Detailed Settings)
Filter Model at Import (Secondary Filter)
Filter Model at Export
Appendix: IFC Terms and Concepts
Appendix: IFC Data Mapping in ARCHICAD
IFC File Types Supported by ARCHICAD

ARCHICAD supports the export and import of the following IFC data file formats:

- .ifc: the default IFC exchange format using the STEP physical file structure
- .ifcXML: IFC data file using the XML document structure. This format is recommended for architects whose partners' applications cannot read the original .ifc format, but can manage XML databases (such as budget, energy calculations, etc.). This format delivers the same model information as the plain .ifc format, but the elements and their properties are stored in a more informative structure. An .ifcXML file is normally 300-400% larger than an .ifc file.
- .ifcZIP: IFC data file using the ZIP compression algorithm. It is the compressed version of .ifc or .ifcXML. An .ifcZIP file usually compresses an .ifc down by 60-80% and an .ifcXML file by 90-95%.

Note: .ifcZIP is compatible with e.g. Windows compressed folders, WinZip, etc. So if the recipient cannot read .ifcZIP, then a ZIP extractor application can open the file into .ifc or .ifcXML format.
ARCHICAD Classifications and Categories in IFC

Element Classifications for IFC
Structural Function Category for IFC
Position Category for IFC

Element Classifications for IFC

In ARCHICAD, you can optionally assign one or more classifications to any project element. A classification makes parameters and functions available to these elements for use by other applications: to organize project data, to make models transparent, to locate elements, for listing purposes, to share exact data, etc.

For each construction element, classifications can be set in the Classification and Properties panel of its Settings dialog box.

ARCHICAD provides a flexible way to classify elements according to any national or company standard classification system. You can assign one Classification value per Classification System in the Elements’ Settings dialog, or from the Interactive Schedule.

Element classification affects the IFC export process: each element is saved to the IFC model according to an IFC Type.

This is displayed in the “IFC Type” item in the Classification and Properties panel (under IFC Properties).

Note: The IFC Type Mapping of ARCHICAD elements by classification depends on the Type Mapping for Export setting of the current Preview Translator. See IFC Translators: Overview.
Structural Function Category for IFC

“Load-Bearing Element” or “Non-Load-Bearing Element”

In collaborating with partners who are using structural programs, you can assign the “load-bearing” classification to elements in ARCHICAD and export this information with the IFC file.

**Note:** By default, Revit Structure will display only walls that have the “load-bearing” property in the “Structural” discipline views. But, if you forget to classify required walls as “Load-Bearing Elements” in ARCHICAD, the structural engineers can also change the bearing function of walls, or they can apply another display discipline (e.g. “Architectural”) in order to show all walls exported from ARCHICAD.

The current IFC standard supports the export of the “load-bearing” IFC property only for the following elements: Wall, Slab, Column, Beam, Roof; elements classified as such in ARCHICAD; and objects having these sub-types.

If you have classified ARCHICAD elements as “load-bearing”, then you can use the Partial Structure Display “Core of Load-Bearing Elements Only” option to display those elements only. This is particularly useful if you wish to export only load-bearing elements to a structural engineer: in this case, just use the “visible elements” export mode on a view that uses this Partial Structure Display option.

This category is useful for listing purposes - for example, you can calculate the materials needed for all load-bearing walls or columns, separately from materials of non-load-bearing elements.

Criteria in the **Find & Select** dialog box include: search for those elements that have been defined as load-bearing or non-load-bearing, or whose Structural Function category is “Undefined”. Since IFC export can be limited to selected elements only, you can - for example - export all selected elements defined load-bearing (not just their Core only, as described in the example above).

The load-bearing data is also a standard property of exported elements. Moreover, if other applications (such as a structural program) also categorize elements according to their load-bearing function, ARCHICAD can filter these elements upon importing them, and such elements will show up in the ARCHICAD model with that classification.

**Position Category for IFC**

“Interior” or “Exterior”

This category is useful if you plan to send an IFC file to partners (e.g. energy analyzers) who are able to differentiate elements by their location in the building. When you export the ARCHICAD model to IFC format, your model elements that are classified as “Interior” or “Exterior” will carry this information to the partner’s application via IFC.

Naturally, the opposite is also true. Since Position (IsExternal) is a standard IFC property for certain building elements (e.g. Wall, Slab, Column, or Beam), if an imported IFC model contains such data, then the appropriate category is automatically added to the respective elements.
Criteria in the **Find & Select** dialog box include: search for elements categorized as either “Exterior” or “Interior”, or whose position is “Undefined”.

Interactive Schedule Criteria are also available to differentiate listed elements by Position.

**Note:** Within ARCHICAD, the Position category is fully usable as an ARCHICAD property (e.g. in **Find & Select** and **Interactive Schedule**). However, it will not be exported as an IFC property for certain element types (e.g. Ceiling (IfcCovering)) which are not supported by the IFC standard.
Export IFC Model from ARCHICAD

There are three export functions:

- **Save as (File menu):** exports the entire current ARCHICAD project or just its filtered content to an entirely new IFC file.

- **Merge to IFC Model (File > Interoperability > IFC):** merges only certain elements or, alternatively, the entire content of the current ARCHICAD project into an existing (unopened) IFC file. For example, use this command if you want to add selected content from an ARCHICAD model to an IFC file from another discipline.

- **Publisher (Document menu):** publishes views to any of the IFC file formats. For each Publisher item, you can vary the Translator, so that the view content can be customized to the needs of the recipient, creating the desired output with a single click.

Regardless of the method, the export process is controlled by an IFC Translator for Export, which defines how ARCHICAD elements should be interpreted and displayed in IFC. As part of the export process (see steps below), you will choose an IFC Translator for Export.

**Save as IFC/Merge to IFC Model**

Both of these export functions (Save as and Merge) follow essentially the same steps.

1. Choose the IFC export command you need.
   - **File > Save as...**
   - **File > Interoperability > IFC > Merge to IFC Model**

2. **File type**

   - **Save as IFC:** From the “Save as type” choose any of the IFC file formats.
   - **Merge to IFC Model:** Only the IFC file types are available.

See IFC File Types Supported by ARCHICAD.
3. Define File Name
   Use the “File name” field to define a file name (Save as), or browse for an existing IFC model (Merge to IFC Model).

4. Choose a Translator for Export
   Use the drop-down list to choose among the predefined or user-defined translators.

Click **Options** to open **IFC Save Options**, with a summary of the selected Translator settings.
5. Filter Model at Export

As needed, further filter the set of elements to export, using the **Elements to Export** dropdown and/or the Model Filter dialog box, both available from IFC Save Options.

*See Filter Model at Export.*

6. Export

Click “Save” (Save as) or “Open” (Merge to IFC Model) to start the export process.

**Hint:** After exporting an IFC model, it is good practice to check the IFC model in an IFC viewer (or in ARCHICAD by reopening the IFC file). There are many free IFC viewers on the market that can be readily downloaded, including:

- DDS-CAD Viewer: [http://www.dds-cad.net](http://www.dds-cad.net)
- Solibri Model Viewer: [http://www.solibri.com](http://www.solibri.com)
- Tekla BIMsight: [http://www.teklabimsight.com](http://www.teklabimsight.com)

**Merge to IFC Model: Protected Content**

In case of Merge to IFC Model, the content of the existing IFC file is protected: merging a file to IFC will only add to it, without replacing any of its elements. This means that if a merged element has the same IFC GlobalId Attribute as an existing element in the IFC file, then the element will be merged using a new IFC GlobalId Attribute. Elements will never be overwritten as a result of a merge. This also means that the Merge to IFC Model command is not suitable for merging changes from one version of an IFC file to another version of the same file!

This illustration shows the result of merging an ARCHICAD model into an existing file that contains an MEP model.
Import IFC Model to ARCHICAD

ARCHICAD provides three methods for importing an IFC model to ARCHICAD: Open, Merge, and Hotlink.

**Open versus Merge**

- **Open:** Opens the entire model or filtered parts of an IFC file as a new project. ARCHICAD will transform the imported elements into corresponding ARCHICAD elements, based on settings in the chosen IFC Translator for Import.

- **Merge** (File > Interoperability > Merge): Available only in Floor Plan view. Inserts an IFC model in whole or in part into a running ARCHICAD project. Merge preserves your running project, without overwriting its data (this is the “Reference model” concept). However, even in this “Reference model”, the merged elements are real ARCHICAD elements based on the IFC-ARCHICAD mapping convention.

  In the Merge process, ARCHICAD automatically generates new IFC GlobalId (ARCHICAD IFC ID) values for all imported elements to avoid overwriting the IFC GlobalIds of the host project. For the purposes of listing and searching, the elements’ original GlobalId values are also retained, in the form of a parameter called “External IFC ID”.

**Overview of IFC Import: Defining how IFC Data are Converted to ARCHICAD**

When you open (or merge or hotlink) an IFC file in ARCHICAD, the program carries out the following steps for each imported IFC element, using the settings in the chosen IFC Translator for Import:

1. Does the IFC element need to be imported to ARCHICAD? (based on the Translator’s “Model Filter for IFC Import” preset)
2. Which ARCHICAD tool (e.g. Wall, Object) should be used to place the IFC element in ARCHICAD? (This is based on the Translator’s “Geometry Conversion for IFC Import” preset.)
3. Which ARCHICAD layer should the element be placed on, and using which attributes? (This is based on the Translator’s “Material and Surface Conversion for IFC Import” preset.)
4. Which ARCHICAD Classification should be assigned to the element? (This is based on the Translator’s “Type Mapping for IFC Import” preset.)
5. Based on the Classification: which Properties are available for the element? (This uses the Property Availability definitions, defined in the Classification Manager of the template file used at import.)
6. Each of these Element Properties is populated with its default Property value. (This uses Property definitions of the Property Manager, in the template file used at import.)
7. The program examines the IFC data assigned to the incoming element, and attempts to generate the equivalent property value for the element in ARCHICAD (This is based on the Translator’s “Property Mapping for IFC Import” preset.)

**Important Note on Translators and Template Files**

- When you import an IFC project using Open or Hotlink IFC: You will choose an IFC Translator for Import from an *external* Template file, selected by you.
- When you import an IFC project using the Merge command: You will choose an IFC Translator for Import from the current host project.

The following sections describe these processes.

- **Open IFC Model**
- **Merge IFC Project**
- **Hotlink IFC File**

**Related Topics:**
- IFC Translators: Overview
- Translators for Import (Detailed Settings)
Open IFC Model

Follow these steps to import IFC data using the Open process.

1. Use File > Open.
2. Select the IFC File Format.
3. Choose the IFC file to import.
4. Use the drop-down list to choose among the IFC Translators.
   
   **Note:** In the Open IFC process (just like the Place IFC Hotlink process), the file is imported based on an IFC Translator for Import, *from a Template file* selected by you. For each listed Translator, its parent Template is shown in parentheses. If the Translator you need is not shown, you may need to search under a different template (see next step).
5. From the Open dialog, click **Options** to see **IFC Open Options**. Here, each loaded template is shown together with its Translators, location, and presets. Choose a Translator from one of the templates and click OK, or click **Browse Template** to load another one.

6. Click “Open” to import the IFC model based on the selected Translator. Additional steps follow, depending on the type of imported model.

*See Additional Options at IFC Import.*
Merge IFC Project

1. Use **File > Interoperability > Merge**.
2. Select the IFC File Format.
3. Choose the IFC file to merge.
4. Choose a Translator
   
   Use the drop-down list to choose among the IFC Translators. These are the IFC Translators in the current host project.

5. Choose **Info** from the Merge dialog to see a summary of the selected Translator settings.
**Note:** In the Merge process, ARCHICAD uses an IFC Translator for Import that you choose from the current host project.

6. Click **Open** to merge the IFC Project to ARCHICAD.
7. Additional steps follow, depending on the type of imported model.

*See next section.*

**Additional Options at IFC Import**

**Building and Site Selection**

If the IFC file contains multiple IfcBuildings and/or IfcSites, then a Building Selection dialog appears, so you can select one Building. The import process can import only one building at a time.

On the left of this selection dialog, view the site and building hierarchy in the tree structure. At right, information is shown on each selected building.

If the “Import all Site geometry” checkbox (at the bottom left of the dialog box) is not enabled, then the selected IfcBuilding will be imported with only the geometry of the specific IfcSite to which the building is assigned.

To import the entire site model, regardless of the chosen building, activate the “Import all Site geometry” option.

**Filter Model at Import**

As needed, further filter the set of elements to import, using the Model Filter dialog box.

*See Filter Model at Import (Secondary Filter).*
Library Parts Location
Choose where to save Library Parts generated during IFC import:

![Library Parts Location dialog box]

The External location is recommended. Make sure you manually link this folder to the project as a Linked Library.

**Notes:**
- When updating a Hotlinked Module, the Linked Library will not be updated! If Linked Library contents have changed, you must update the library manually.
- Make sure that the target folder is write-enabled at the time of import. If it is not, the import process will fail.
- In Teamwork, the Linked Library option is not available; generated Library Parts are saved to the Embedded Library.

**Vertical Position of Merged IFC Model (only at Merge IFC Model)**

View or change the options in the **Vertical Position** dialog box, to define the vertical position of the merged model in the host ARCHICAD project.

- **Original:** When using the **File > Interoperability > Merge** command to import an IFC model, ARCHICAD recreates the original vertical position of the merged model inside the host project by default. ARCHICAD will automatically match stories and create
offsets to ensure that the merged model is in the same vertical position as in the IFC source file.

- **Custom**: Alternatively, click **Custom** to manually set the merged model’s vertical position.
• From the pop-up menu, choose the story of the incoming IFC project which should be placed onto the current story. In the list, each story of the IFC model is shown with its own elevation in parentheses.

- **Elevation Offset:** To adjust the vertical position of the imported model, enter a positive or negative value in the Elevation Offset at the bottom of the dialog. By default (and this is recommended), the Elevation offset value is the absolute difference between the elevation values of the chosen IFC model story and the current ARCHICAD story.

**Result**

- See the Result field to see which merged stories will be placed on which stories of the host.
- In either case (**Original** or **Custom** vertical position), new stories are created above or below the host project’s story range, if they are needed to accommodate extra stories in the merged project.
• New stories (if any) are marked with a plus sign. These stories will be created in the Host when you click OK to close the dialog box.
**Hotlink IFC File**

Place IFC files as hotlinks directly into the currently open Project as protected reference content. You can place this hotlink as many times as needed. Thus, in a project using repeated building blocks/parts, you do not need to request a huge IFC file based on the entire project - a smaller IFC file that contains just the module is enough.

**Place IFC Hotlink**

The steps for placing an IFC hotlink are the same as when placing a PLN-based hotlink, with some additional options described here.

1. As when placing any other Hotlink, use **File > External Content > Place Hotlink**.
2. From the New Hotlink Module dialog, choose an IFC format file and a Translator for Import.

![New Hotlink Module](image)

---

**Note:** In the Place IFC Hotlink process (just like Open IFC), the hotlink elements are imported based on an IFC Translator for Import, *from a Template file selected by you*. For each listed Translator, its parent Template is shown in parentheses. If the Translator you need is not shown, you may need to search under a different template (see next step).
3. From the Open dialog, click **Options** to see **IFC Open Options**.

Here, each loaded template is shown together with its Translators, location and presets. Choose a Translator from one of the templates and click OK, or click **Browse Template** to load another one.

*See IFC Translators: Overview for more information.*

4. Click **Select** to return to the **Place Hotlink** dialog box.

**Note:** When hotlinking an IFC file, make sure you set the Elements’ Elevation option to Keep Elevation! Otherwise, the imported model may “fall apart” when its elements are placed in a different story structure.
5. Click **Place Hotlink**.
6. You are prompted to choose where to store the library parts.
   See *Library Parts Location*.
7. If the IFC Translator for Import requires it, the **Model Filter for Import** also appears, to allow for further element filtering before placing the hotlink.
   See *Filter Model at Import (Secondary Filter)*.

**Layers of IFC Hotlink Elements**

When placing an IFC file as a Hotlink, remember that the imported elements' own Layers depend on the Layer Conversion settings of the Translator for Import that you are using.
See *Layer Conversion for IFC Import*.

**Avoid Model Element Intersections with Hotlinked IFC Elements**

Like other IFC content imported to ARCHICAD, IFC-based Hotlink content depends on the settings of the IFC Translator used for import.
If you are importing elements as native AC construction elements, unwanted intersections can be a problem.
To avoid intersections, do one of the following:

- Make sure the imported IFC elements are placed onto a separate ARCHICAD layer. (Check the Layer Conversion setting of the IFC Translator used for import.) (See Layer Conversion for IFC Import.)

  **Note:** ARCHICAD will automatically apply a unique Layer Intersection Group setting to this new Layer. Elements whose layers have differing intersection numbers never intersect.

- Use the Translator’s Geometry Conversion settings to create Objects or Morphs out of the imported elements. Such elements do not participate in automatic element intersections.

  ![Geometry Conversion for IFC Import]

*Watch the Video*
Detect IFC Model Changes

This command (File > Interoperability > IFC > Detect IFC Model Changes) detects the geometric differences between two versions (IFC files) of a single model, and merges only the modifications (new, deleted and modified elements) into the currently running project (that project can also be an empty one). Modifications can be viewed and managed using ARCHICAD's Mark-Up tool in both 2D and 3D views.

You can restrict the change detection to only a part of the model (for example, to elements on the ground floor) or to particular element types (for example, just columns). The following geometric differences are detected:

- **New Elements**: elements created in the newer version that did not exist in the earlier version.
- **Deleted Elements**: elements that existed in the earlier version but were deleted from the newer version.
- **Modified Elements**: elements that have been modified (in their position and/or size) from one version to the next.
Notes

- It is important that the two IFC files being compared originate from a single application and a single project, because the comparison process is based upon the elements’ GlobalId numbers in the IFC model. If there are no identical IFC GlobalIds in the two versions, then all elements will be considered either new or deleted.
- You must correctly identify which IFC file is the older project version and which the newer version.
- The change detection applies only to 3D elements - not to any of the 2D IfcAnnotation (lines, texts, fills etc.) and IfcGridAxis elements that may be stored in the IFC file.
- Since the changes are merged into the current ARCHICAD project, we recommend that you save the ARCHICAD project before using the Detect IFC Model Changes command.
- Independently of any model exchange workflow with other applications, the Detect IFC Model Changes function can also be used to compare two versions of an ARCHICAD project: you must have saved both versions of the project as IFC files. This works if the Translator’s “Data Conversion for IFC Export” settings are set to keep the ARCHICAD IFC IDs intact.

See IFC Global Unique Identifier Attribute (GlobalId)

- You can use other Mark-Up functions (e.g. Comment, snapshot) to manage changes, which can be used as part of a BCF-based workflow.

Follow these steps to compare two IFC files:
1. Use File > Interoperability > IFC > Detect IFC Model Changes.
2. Define a location for generated library parts.

See Library Parts Location.
3. In the appearing IFC Model Change Detection Wizard: Use the Browse buttons to locate and select the IFC model, noting the order in which the two files were created (“Older” and “Newer”). Keeping track of the versions is crucial to ensure the proper detection and interpretation of the changes.
4. From the pop-up list, choose an IFC Translator for Import. Translator settings which will be applied in this process include:
   - the Model Filter options for “IFC Domain” and “Structural function” (these are the default filters for comparing elements); and
   - the Material and Surface Conversion settings.
     Note: Layer assignment is not defined by any translator; it is defined in a later step.
   Click Next.

5. Filter Elements to be Compared
Although the translator chosen in the previous step defines the default filters to be used for the elements being compared, use this page to further limit the model. In fact, you can define entirely different filters or customize them.

Use this dialog box to optionally narrow the set of elements to be compared in the two files:

- **IFC Domain**: Use one of the predefined domain filters to define the element types to be compared. By default, it is set to match the IFC Domain setting (in Model Filter) of the translator chosen above.
  - All element types will compare all elements from the two files.
  - The **Structural** or **MEP** domains will consider only IfcBuildingElements or IfcDistributionElements, respectively.
  - The **Custom** domain filter can be created using the Options button – e.g., you can consider just beams (IfcBeam) or just columns (IfcColumn).

- **Structural Function**: If the IFC files to be compared include elements classified by Structural Function (that is, LoadBearing IFC Property is assigned to elements), then use this setting to filter load-bearing elements, for example as part of a structural-architectural data exchange. By default, it is set to match the Structural Function setting (in Model Filter) of the translator chosen above.
**Note:** Use Structural Function filtering only if you are certain that your fellow professional, with whom you are exchanging data, is using and able to export the LoadBearing IFC Property.

- **Element Type:** Optionally, further fine-tune the initial filtering set above (IFC Domain and Structural Function). To make filtering easier, group element types by Story, Layer, Owner, or by both Story and Layer.

Click **Next**.

6. **Assign New/Deleted/Modified Elements to Layers**

This page summarizes the detected changes, by number and type: New, Modified and Deleted elements. These changes will be merged to ARCHICAD as Mark-Up Entries. Choose two layers onto which to place the elements. This will differentiate the elements when they are merged.

![IFC Model Change Detection Wizard](image)

7. **Merge Changes to the Project**

Click “Merge” to send the changes to the project as Mark-Up Entries. The detected changes will be merged into the project and placed on the two layers you defined.

8. **Vertical Position**

Define the vertical position of the merged content.

*See Vertical Position of Merged IFC Model (only at Merge IFC Model).*

9. **View changes with Mark-Up.**

The Mark-Up Palette appears automatically and lists the changes as Mark-Up Entries, using three mark-up styles: “New”, “Deleted” and “Modified Elements”. Thus, the elements are easily distinguishable on screen according to their specific style. Entries can be sorted by Style and by their Floor Plan View.

Elements from the two compared models are categorized separately by the Mark-Up function:

- Elements from the older version (that is, the Deleted and Modified elements from the older version) are shown as “Correction”
- Elements from the newer version (that is, the New and Modified elements from the newer version) are shown as “Highlighted”

Each of these categories uses different Mark-Up Styles and their elements can be edited accordingly.

Functions on the Mark-Up palette enable you to view, select or zoom to the elements in the entries.

**Hint:** The default colors for marking different change types can be modified in the Mark-Up Styles palette (Options > Element Attributes).

Since the elements from each of the two model versions are categorized separately in Mark-Up, each Modified element entry contains a pair of elements: one element from the older model version, shown as “Correction”, and a newer-version element, shown as “Highlighted.” Their different colors make it easy to distinguish them. Moreover, each element in the pair is placed on a different layer (see Step 6 above). You can check any element’s layer by reading its Info Tag, which appears when you hover your cursor over any element.

Elements detected as changed become part of the project and are placed on separate layers depending on their version (older or newer). To each of these elements, the Mark-Up function assigns these elements a category: either “New”, “Deleted” or “Modified”.

Now what can you do with them?

- **Deleted Element:** You can leave it in as part of the project (placing it on a separate layer); or you can delete it together with its Mark-Up Entry, by clicking “Delete Entry” in
the Mark-Up Palette. You can also use “Delete Entry” *without* deleting the elements in the Entry.

- **New Element:** Since it has a Highlighted status, deleting its entry will not delete the element, it will just lose its Highlighted status. Then you can use the element as you wish (or even delete it from the project). A New element will be deleted together with its Mark-Up Entry only if you first remove its Highlighted status (click the “Remove Highlight” button).

- **Modified Element:** This pair of elements includes one each that is “Old” and “New”, with the same options as described above for “Deleted” and “New” elements. That is, if you do a Delete Entry, the older-version element can be either retained or deleted, while the newer-version element will remain intact, while losing its Highlighted status.

**Hint:** If you delete a Mark-Up Entry by mistake, use Undo.
**Update with IFC Model**

This command (File > Interoperability > IFC > Update with IFC Model) updates the current ARCHICAD project content with an IFC model.

Use this if the ARCHICAD project and the IFC file contain elements in common, and if you want to add to or modify the project elements’ data using IFC data.

- Exported ARCHICAD properties that are mapped to IFC properties are updated, provided that the correct Translator settings are used at both export and import. (ARCHICAD 22 and later)

- “Elements in common” are those whose GlobalId Attribute is the same in both the host project and the imported IFC model.

- “IFC data” include IFC Attributes, IFC Properties and IFC Classification References

Thus, this command is optimized for tracking and updating changes to property data. This command is not suitable for updating model element changes.

**Notes:**

- Property update using this command works properly only if Property and Type Mapping definitions are used correctly and consistently, both at export and at import
- Deleted elements and modified elements are ignored!
- Geometry data (size, color, layer) will not be updated or modified.
- Properties of locked project elements will not be updated or modified.
Workflow for Update

1. Go to **File > Interoperability > IFC > Update with IFC Model**.
   
   In the Open dialog:
   
   - Browse for an IFC model.
   - Choose an appropriate Translator for Import. The Translator should use Property and Type Mapping settings that are analogous to those used when the original ARCHICAD model was exported to IFC.

2. Click Open.

3. In the appearing dialog, set the update options as needed *(see Update Options, below)*.

4. Click **OK**.

Example Workflow: Property Mapping at Export and Import

1. The ARCHICAD model is exported to IFC, using the **File > Save As IFC** command.
   
   ARCHICAD elements are exported together with their IFC data. Based on the **Translator for Export - Property Mapping for Export** preset (which also depends on the Type Mapping for Export preset), ARCHICAD properties are mapped to IFC properties.

2. An external consultant works on the IFC model, deleting some properties, modifying others, and adding some new ones.

3. The edited model is imported back to ARCHICAD using **File > Interoperability > IFC > Update with IFC Model**.

4. New and modified IFC properties are added and updated in the ARCHICAD model, based on the mapping definitions of the **Translator for Import - Property Mapping for Import** preset.

   - **Important**: To map the properties back to existing ARCHICAD properties, make sure you activate the option to **Import as ARCHICAD Properties**.
Update Options

Check the options to specify which data to update in the ARCHICAD model.

**Note:** These update data options are only relevant for incoming IFC Attributes and IFC Classification References. Properties are updated based on Translator-based property mapping definitions at export and import.

- **Merge new model elements from IFC**
  - **Merge new from IFC:** IFC Attributes and IFC Classification References which do not yet exist in the host project will be added to elements in common.
  - **Override existing if modified in IFC:** For elements in common, the project data will be modified by the corresponding data values from the merged IFC file. Corresponding data: Attribute and Classification Reference must have the same name.
    **Note:** This is a full override: all values for data items having the same name will be modified.
  - **Remove existing if missing in IFC:** For elements in common, project data which do not exist in the merged IFC file will be removed.
IFC Project Manager

The IFC Project Manager (File > Interoperability > IFC) provides a hierarchical overview of the current project's IFC model database. Each model element is listed with its IFC attributes and properties.

Most of these are inherited from import/export IFC standards set elsewhere (e.g. Type Mapping and Property Mapping presets of the project's IFC Preview Translator.) However, you can edit values in IFC Project Manager for any specific element, and/or create custom IFC properties or Property sets as needed.

Related Topics:

Functions of the IFC Project Manager
Navigating in the IFC Project Manager: Tree Structure
Navigating in IFC Project Manager: Attributes and Properties
Assign or Edit IFC Property/Attribute Values
Create New, Custom IFC Property
Apply Predefined Rules
Using Assignments in IFC Project Manager
Using Type Products in IFC Project Manager
Functions of the IFC Project Manager

- View all IFC model entities generated from the ARCHICAD project (including IFC import content) in a hierarchy
- View all IFC data available for project elements
- Create new IFC data (custom IFC Properties and Classification Reference) for any model element
- Group elements or assign entities to elements (called IFC Assignments) and manage their IFC data
- Manage IFC Type Products assigned to elements with their IFC data
- Assign elements directly to the IfcSite or IfcBuilding. For example, the neighboring buildings and site context elements (trees, fences, roads, vehicles etc.) can be assigned to the IfcSite; thus, their default direct relation to their home story is removed.
- Update the IFC model with the modifications of the ARCHICAD project
- Navigate easily between the ARCHICAD model and the IFC model
- Filter the IFC model by elements visible in the current view
- Find elements both in the IFC and ARCHICAD models by their IFC ID's
- In Teamwork, reserve the IFC Project Manager to modify data for the following elements: IfcProject, IfcBuilding, IfcSite, Assignments, and Type Products. To modify data for model elements (e.g. IfcWall, IfcColumn, IfcBeam) in IFC Project Manager, you must also reserve the elements themselves.

The IFC Project Manager palette is a modeless dialog box, so you can keep it open while working in the ARCHICAD project.
Navigating in the IFC Project Manager: Tree Structure

The tree structure (upper left side of the IFC Project Manager) displays the IFC model hierarchy and lists IFC Entities of the current project according to their “IFC Type” classification.

See IFC Model Hierarchy.

ARCHICAD Elements in IFC Story Structure

In ARCHICAD, all elements and objects are linked to their Home Story. Therefore, by default, elements are listed in the IFC model hierarchy under the IfcBuildingStorey that corresponds to their Home Story.

You can break this link (to the IfcBuildingStorey) by dragging the element out of its IfcBuildingStorey location into the IfcSite. For example, a neighboring building modeled with a Morph can be placed into the Site folder.
You can also place elements into the Building (such as an element that is logically tied directly to a particular building rather than a story).

To return an element to its automatic IfcBuildingStorey classification (corresponding to its Home Story), just drag it out of the IFC Project Manager.

**Filter Data Shown in Tree**

Click **List visible model elements only** to narrow the tree to those elements that are visible in the current ARCHICAD model view.
Synchronize Project Manager Data with Model

When elements are created or deleted in the ARCHICAD model, the tree will not register these changes automatically. If a refresh is needed, a message appears below (“Tree is not up-to-date!”). Click the “Synchronize” button to refresh it.

Find Selected Model Elements in Tree; Find Selected Tree Elements in Model

- To find and select IFC Entities of the tree in the ARCHICAD model, select them in the tree and click **Show list selection in model**. The program displays and selects the elements in the active window (Floor Plan or 3D view only).
- To find and select ARCHICAD model elements in the tree, select them in the Floor Plan or 3D window, and click **Show model selection in list**.

Find Tree Elements by IFC Identifiers

An IFC model checker might alert you to modeling errors. You can locate such elements in IFC Project Manager based on their IFC identifiers:

- ARCHICAD IFC ID (the Globalid IFC attribute automatically assigned by ARCHICAD to each element)
- External IFC ID (the Globalid IFC attribute assigned to each IFC element imported to ARCHICAD)

Switch to the search mode using the Find by GlobalId tool (third icon underneath the tree).
Note: The External IFC ID is created when importing an IFC model to ARCHICAD using either Merge or Hotlink IFC. This is done to prevent existing ARCHICAD elements from being overwritten by identical elements being imported from IFC. (The External IFC ID stores the original ID of the model elements as defined in the external file).

Type the identifier (or any portion of it) that you are searching for into the empty field below the tool, and then click the “Search” button.
Select any item in the “Search result” list to show that element in the tree. Click “Show list selection in model” to find and select the element in the ARCHICAD model.

**IFC Assignments View vs. IFC Type Products View**

You can group IFC elements by Assignments and/or IFC Type Product. See the descriptions of [IFC Assignments](#) and [IFC Type Product](#).

To view these groupings in IFC Project Manager:
Switch to “Assignments” or “Type Products” view/definition mode using the first or second icon, respectively, underneath the tree.

To narrow the displayed Assignment/Type Product data to that of the selected elements only, click the “Filter for selected element(s)” button.

**Related Topics**

- Using Assignments in IFC Project Manager
- Using Type Products in IFC Project Manager
Navigating in IFC Project Manager: Attributes and Properties

Select a project element in the tree: for this selected item, the right side of IFC Project Manager displays:
- available IFC Attributes
- Properties grouped in Property Sets
- Classification References

In case of multi-selection, the IFC data of the last-selected element are shown. At the top of the list, the numbers of selected/editable elements are shown. Many IFC Property and Attribute are defined automatically, based on the Property Mapping rules defined in the IFC Translator for Export.

Filter Data Shown in IFC Project Manager

The predefined IFC data types are very numerous, and you usually don't need to see all of them at once in IFC Project Manager. Use the two filter buttons at top right to cut down on the data shown here:
Show only Properties from Active Preview Translator
Activate this button to display only those data based on the Property Mapping preset of the Preview Translator.

See also Preview Translator and Property Mapping for IFC Export.
If you do not activate this filter, then IFC Project Manager also displays any new properties created here and in the Element Settings dialog boxes, as well as custom data added during an import process.
Show Only Items with Values
Use this toggle to display only those data which have assigned values: that is, its checkbox is enabled.

Note: A property whose field is empty, but whose checkbox is enabled, counts as a property that has a value assigned.
Assign or Edit IFC Property/Attribute Values

For any selected element in IFC Project Manager, overwrite any editable property or attribute value as needed.

The display of Attributes and IFC Properties in IFC Project Manager indicate the data status:

- **BLACK**: Editable items can be overwritten with a custom value.
- **Checkbox**: An active checkbox indicates that this property or attribute has a value.

**Note**: Don’t forget that if you enable “Show only items with values”, then items without a value are not shown here at all. See Filter Data Shown in IFC Project Manager.

- **RED ARROW**: A customized value is shown with a red arrow: click it to revert to the original value.
- **GREY**: cannot be modified here in the IFC Project Manager.
  - The element's **IFC Type** depends on the Type Mapping definition of the Preview IFC Translator. This item is greyed and not editable here.
- **Chained**: This value is derived from some other interface. For example:
  - The **IsExternal** and **LoadBearing** IFC properties (see image below) are greyed and not editable here.
    - These values depend on what is set in the ARCHICAD element's Settings dialog: the “LoadBearing” value comes from its Structural Function; and the “IsExternal” value comes from the Position.
- If a Property Set no longer contains any Properties, it will be deleted from the list automatically.
Create New, Custom IFC Property

IFC Properties are additional (mostly IFC Type-specific) parameters assigned to an IFC Entity. Standard, so-called “IFC2x3 Schema” data are defined by buildingSMART and stored in property sets whose names begin with the prefix “Pset_”

You may wish to create a custom Property or Property Set (e.g. an office-standard Property Set).

1. In IFC Project Manager, click **New**.

2. In the appearing dialog box, enter a new custom Property Set name (Pset); or else choose from the list of existing Property Set names defined previously for the same element type (click the arrow icon to access this list). For example, if you are creating a new Property for an IfcWall, the list contains all the Pset names earlier assigned to other IfcWalls.
**Note:** To avoid errors (and to keep the standard property definition rules), do not use the standard “Pset” prefix when giving a name to your custom Property Sets.

3. Enter a new Property name.

4. Choose a Property type (single, enumerated, complex, etc.) as described in the following table.

<table>
<thead>
<tr>
<th>Property type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Value</td>
<td>A property object which has a single (numeric or descriptive) value assigned.</td>
</tr>
<tr>
<td>Enumerated Value</td>
<td>A property object whose value is chosen from an enumeration.</td>
</tr>
<tr>
<td>Bounded Value</td>
<td>A property object which has a maximum of two (numeric or descriptive) values assigned, the first value specifying the upper limit and the second value specifying the lower limit.</td>
</tr>
<tr>
<td>Table Value</td>
<td>A property object which has two lists of (numeric or descriptive) values assigned, corresponding to a table with two columns.</td>
</tr>
<tr>
<td>List Value</td>
<td>A property that has several (numeric or descriptive) values assigned, corresponding to an ordered list.</td>
</tr>
<tr>
<td>Reference Value (IfcCalendarDate only)</td>
<td>A property object which references to calendar date-type entity (day, month, and year).</td>
</tr>
</tbody>
</table>

5. Set the value type to label, text, integer, boolean, etc.

*See also* **Unit Conversion for IFC Export**

<table>
<thead>
<tr>
<th>Value type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IfcAreaMeasure</td>
<td>REAL type value of the extent of a surface. Value must be set in square meters, but is recalculated at export based on Area Unit settings.</td>
</tr>
<tr>
<td>IfcBoolean</td>
<td>A defined data type of simple <strong>BOOLEAN</strong> type. Value: TRUE or FALSE.</td>
</tr>
<tr>
<td>Value type</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IfcIdentifier</td>
<td>An identifier is an alphanumeric STRING (max. 255 characters) which allows an individual thing to be identified. It may not provide natural-language meaning.</td>
</tr>
<tr>
<td>IfcInteger</td>
<td>A defined data type of simple INTEGER type. The number of bits contained in the IfcInteger is unrestricted, but in practice it is implementation-specific.</td>
</tr>
<tr>
<td>IfcLabel</td>
<td>A label is the term by which something may be referred to. It is a STRING (max. 255 characters) which represents the human-interpretable name of something and shall have a natural-language meaning.</td>
</tr>
<tr>
<td>IfcLengthMeasure</td>
<td>REAL type value of a distance. Value must be set in meters, but is recalculated at export based on Length Unit settings.</td>
</tr>
<tr>
<td>IfcLogical</td>
<td>A defined data type of simple LOGICAL type. Value: TRUE, FALSE or UNKNOWN.</td>
</tr>
<tr>
<td>IfcMonetaryMeasure</td>
<td>REAL type value of an amount of money without regard to its currency. The currency unit can be set at Currency Unit settings.</td>
</tr>
<tr>
<td>IfcPlaneAngleMeasure</td>
<td>REAL type value of an angle in a plane. Value must be set in radians, but is recalculated at export based on Angle Unit settings.</td>
</tr>
<tr>
<td>IfcPositiveLengthMeasure</td>
<td>Length measure shall be greater than zero. Value must be set in meters, but is recalculated at export based on Length Unit settings.</td>
</tr>
<tr>
<td>IfcRatioMeasure</td>
<td>REAL type value of the relation between two physical quantities that are of the same kind. Input given in percent is expressed as a decimal value: e.g. 25% becomes 0.25.</td>
</tr>
<tr>
<td>IfcReal</td>
<td>A defined data type of simple REAL type. The domain of Real is all rational, irrational and scientific real numbers. Here the precision is unconstrained, but in practice it is implementation-specific.</td>
</tr>
<tr>
<td>IfcText</td>
<td>Alphanumeric STRING of characters which is intended to be read and understood by a human being. It is for information purposes only. No character number limitation.</td>
</tr>
<tr>
<td>IfcTimeMeasure</td>
<td>REAL type value of the duration of time periods. The time unit can be set at Time Unit settings.</td>
</tr>
<tr>
<td>IfcVolumeMeasure</td>
<td>REAL type value of the solid content of a body. Value must be set in cubic meters, but is recalculated at export based on Volume Unit settings.</td>
</tr>
</tbody>
</table>

**Note:** All other “Measure”-type properties not listed in the above table are handled and exported without any unit settings.
- Newly created IFC data will appear in the defined Property Set or under “Classification References” in the IFC Project Manager, as well as in the element Settings dialog among the listed properties.
- Such newly created IFC data appear with a red X in front, meaning that you can delete them at any time.
Create New Classification Reference

A Classification Reference (IfcClassificationReference) arranges IFC elements into a category. You can assign an Item Reference identifier, a classification Name attribute and some other optional parameters to all project elements (such as the building, the stories, the building elements, or the zones).

You can classify elements with this system both in IFC Project Manager and the element Settings dialog.

Example
1. In IFC Project Manager, click **New**.

2. Click the **Classification Reference** button and assign it a new name. Here, too, you can choose from the list of existing Classification Reference names defined previously for the same element type (click the arrow icon to access this list).
Assign values. The Classification Reference has 7 available items (the most important ones are the “Name” and the identifier (“ItemReference”) of the classification reference data) for defining/editing.

To define values of a custom-defined Classification Reference data, type them manually or use the Apply Predefined Rule command:
See Apply Predefined Rules.
Apply Predefined Rules

Use this function to create custom-defined Classification Reference data based on automatic (.xml-based) rules.

1. In IFC Project Manager, click **Apply Predefined Rule**.

There are three types of predefined rules, based on their differing structures:
- “Tree list” rule: select an element from a tree-structure database to create the new data
- “Table” rule: select a row from a table to create the new data
- “Command” rule: start the rule-command to create the new data

The program contains factory-defined built-in rules (these vary depending on your localized version of ARCHICAD).
- The available rules are accessible from the following folder, and the newly created rules should also be saved to this location:
  - On Windows: `GRAPHISOFT\ARCHICAD\Defaults\IFC Rules`
  - On Mac: `Applications\ARCHICAD\Defaults\IFC Rules`
Apply Predefined Rule: Example

Assign classifications to a number of roof slabs (IfcSlabs) using the “OmniClass / Table 21 - Elements” rule:

1. In the model, select the Slab elements to be classified (you can use Find & Select). Open the Settings dialog box and click on “Manage IFC Properties” from the Classification and Properties panel. Alternatively, select the corresponding IfcSlab entities from the IFC Project Manager tree.

2. Click on Apply Predefined Rule. From the dialog box, choose the “OmniClass / Table 21 - Elements” rule.

3. In the database Search field, enter the text “roof”, and click the search icon to execute the search. (This searches among the rules in the databases (tree list and table) based on any partial text.)

4. From the Search result area, select the “Roof Decks, Slabs, and Sheathing” title.

5. Click “Apply”. The Classification Reference is generated, with the name of “Roof Decks, Slabs, and Sheathing”, with an ItemReference value of “21-02 10 20 20”, and additional data corresponding to the OmniClass standard.
Notes

- Once you select an element, only the applicable rules are available in the “Select Rule” list (for example, if you have selected IfcProject, then the “Concept Design BIM 2010 (US GSA) / Project Client/Owner and Project Architect” rule is available). All the non-applicable rules are grayed.
- IfcElement includes building, distribution (MEP) and furnishing elements.
- Certain rules are not available in Settings dialogs if the rules are related to elements which do not have Settings dialogs (for example, IfcBuilding, IfcBuildingStorey, IfcOccupant, IfcProject and IfcGroup).
- You can create and edit your own rule in .xml format. It is recommended to peruse the structure of an existing rule file (which may contain multiple rules), and to create a similar new rule by duplicating it under a different name.
Using Assignments in IFC Project Manager

Use IFC Assignments (IfcRelAssigns) to create groups of project elements. The major Assignment Types of the IFC4 standard can be seen in IFC Project Manager.

- IFC Groups
- IFC Zones
- IFC Systems
- IFC Building Systems
- IFC Distribution Systems

*For more information on each Assignment type, see IFC Assignments.*

To group IFC elements by IFC Assignment in IFC Project Manager:

1. Use the New button to create a new Assignment under an Assignment Type
2. Drag relevant IFC entities from the top tree view into the newly created Assignment Relation item

This process is described below.
Create New Assignment Relation

1. Switch to Assignment view mode by clicking the Assignments icon. (See illustration above).
2. Click on an Assignment type to select it (e.g. IFC Zones)
3. Click the “New” button at the bottom of the window.

As a result:

- A **New Assignment** (e.g. New Zone) is created for the selected Assignment Type.
  - A New Relation folder is created within the new Assignment. You can now add related IFC entities to this folder.
  - A **New Spatial Relation** node is also created within the new Assignment. (Not available for IFC Groups). You can add related spatial entities to this node.
4. Drag related items from the IFC Entity tree above into the New Relation folder and/or the Spatial Relation node.

**Hint:** Shift+click to multi-select, and grab the entities by their icons to drag them.
Click and Drag IFC Entity into New Relation Folder

See Examples of Assignments.

Which Entities Can Be Added?

Relation Folder: Entities that can be added to a Relation Folder depend on the Assignment type:

- IFC Groups: Drag any project elements here to create logical group(s)
- IFC Zones: Drag IfcSpace elements here
- IFC Systems: Drag IFC spatial types (IfcSite, IfcBuilding, IfcBuildingStorey and IfcSpace) and any of their related elements
- IFC Distribution Systems: Drag MEP elements (IfcDistributionElement and/or sub-elements) here.

Spatial Relation: Spatial IFC elements (Site, Building, Story, Zone) can be added to the Spatial Relation node.
Rename Assignment Item
Rename any newly created item using the Name Attribute field on the right side of the dialog.

Delete Assignment or Entity
To delete a Relation entity or Assignment, select it and click the “Delete” (red X) button.

Manage Assignment Hierarchy
- Within a particular Assignment Type, drag and drop entities among different Relation folders
- Define new hierarchies: Select an existing Assignment or Assignment Type item and click “New” to define a sub-item. This way, you can create a multi-level hierarchy within an Assignment Type.
- To copy an item, hold down Ctrl/Alt while dragging it
- To make a child Assignment into a parent Assignment, select it and drag it outside of the dialog box; it will reappear in the hierarchy as a parent Assignment

**Examples of Assignments**
- Create an IfcZone named “Security Zone”, which will group together all of the project’s IfcSpaces that have a security function.
- Group elevators in a vertical circulation system, which is a child system of a mechanical system.
MEP Modeler Elements: Automatic Assignment to IFC Distribution System

If your project uses the MEP Modeler Add-On, the MEP elements can be automatically added to the IFC Distribution System Assignment, corresponding to each element’s MEP System. For example:

1. At the IFC Distribution Systems Assignment Type: Click the New button to create a new, empty IFC Distribution System.

2. Select this new Distribution System, then click on the MEP icon at the right (underneath the Assignment list).
3. Choose the desired MEP System from the drop-down menu (e.g. Fresh Air). The Distribution System is renamed accordingly.

4. All elements that belong to this MEP System (e.g. Fresh Air) are automatically added from the tree into the “New Relation” folder.

**Note:** You can also add any other Distribution element manually to this folder.
To delete MEP System elements from an IFC Distribution System, select the Distribution System item (e.g. Fresh Air), and choose “Disconnected” from the drop-down menu of the MEP System options.
Using Type Products in IFC Project Manager

The IFC Project Manager displays all the IFC Type Products that exist in the project, plus all the elements which refer to them. IFC Type Products are another way to group project elements.

To see elements by Type Product, switch to the Type Products view/definition mode using the second icon underneath the tree.

Property Mapping rules can be defined for Type Products. See an example here: Example 4: Mapping Rule by IFC Type Product.

An IFC Type Product defines a particular style/type of other entities by relating to them with common IFC Attributes and Properties. For example, IfcWindowStyle is an IFC Type Product, to which many windows (IfcWindow) refer.

IFC Type Product entities are generated for ARCHICAD elements based on the Type Mapping definition in the Translator for Export.
Select a Type (e.g. IfcWallType) to check its IFC data on the right side of the IFC Project Manager. The IFC data of the resulting IFC Type Product are not editable by default; they are displayed in italicized gray type, and all IFC data on the right side are grayed.

**Edit IFC Type Product**

You may wish to edit an IFC Type Product. For example:

- Change its Name Attribute
- Define a value for an Attribute or standard Property that has no value yet
- Modify existing Property data
- Create a new custom Property or Classification Reference

See *Create New, Custom IFC Property*. 
To edit the IFC Type Product, first enable it for editing: click on the “Edit/New Type” button.

Then make the desired modifications in the attributes/properties on the right.

**Change IFC Type Product Definition - Subtype**

For some ARCHICAD elements, definition as a particular IFC Type Product is not always clear-cut - typically the case for HVAC elements (IfcDistributionElements).

Suppose you have an MEP Modeler-defined Pipe element, classified as IfcFlowSegment. The program will automatically choose a subtype of the IfcFlowSegmentType (e.g. IfcPipeSegmentType).
To change this to a different subtype of the IfcFlowSegmentType (such as IfcDuctSegmentType):
1. Make the IFC Type Product editable, using the “Edit/New Type” button.
2. Use the “Change Type Product” drop-down menu.

Combine IFC Type Products Into One

It is possible to combine several IFC Type Products entities into a single IFC Type Product. This works for all element types except Doors/Windows (see below).

For example, suppose you have two concrete Slabs of different thicknesses. By default, these will be classified as two separate IFC Type Products (IfcSlabType), because thickness is a significant property of slabs. But you want to combine them into a new, single type named “Concrete slabs.”
1. Select one of the Type folders and make it editable using the “Edit/New Type” button.
2. From the other Type folder, select the IfcSlab drag it onto first Type folder.
3. Change the Name Attribute of the Type folder (which now contains two elements) to “Concrete slabs” (see illustration below).

Combine IFC Type Products of Doors and Windows

Combining doors or windows is more complicated, because some of their major parameters are generated from GDL data, and cannot be modified as a result of combining elements.

Such parameters are the OperationType Attribute and the panel and lining attributes. Suppose you have two doors that are identical in all their data (e.g. size, panel type), but their Operation Types are different: one opens to the right, the other to the left. These two doors will be classified under two different IFC Type Products: these two Types will have the same name, but their “OperationType” IFC Attributes will differ.

To have both doors belong to the same IFC Type Product, select one of the doors and place it in the other (second) type.

As a result, a new, common type is created that uses all of the data of the second type (such as Name Attribute, Properties, Classification Reference, etc.). This new common type is the one that will be exported, and which will be assigned to both of the doors. This common type can be renamed and its data modified.
At the same time, the two original types will remain as so-called linked types: they will link only data which is generated and which differ for each of the two doors (in this case, their OperationType Attributes). In other words, both doors will belong to a single type, which includes all of the data they have in common, but they will also maintain certain IFC data that were different for each and cannot be combined (see illustration below).

Reset Type
“Reset Type” means that all edited IFC data will revert to their original values, and the new data will be deleted.

- When Reset Type is applied to a selected IFC Type Product (e.g. IfcWallType) that has been edited, the Type’s original data are restored (newly modified IFC data are lost), and the Type is no longer editable. If the Type now contains new elements as a result of combining Types, then those elements will return to their original locations.
• When Reset Type is applied to a single element (e.g. IfcWall) that has been moved into a different Type, that element will return to its original location.
Manage IFC Data at Element Level

ARCHICAD elements created from imported IFC model elements display their standard and custom IFC data, at the element level, in their respective Settings dialog boxes. New IFC data can be added to the elements manually or automatically, based on predefined rules in the Manage IFC Properties dialog, which is opened from Element Settings (Classification and Properties panel). The interface of the Manage IFC Properties and all its functions are the same as the right side of the IFC Project Manager dialog box.

For detailed function descriptions, see IFC Project Manager.

The new data appear in the Classification and Properties panel of the element Settings dialog, under IFC Properties. Here, you can assign values to the available data fields that are still empty.
# Working with IFC Data: Element Settings vs. IFC Project Manager

<table>
<thead>
<tr>
<th></th>
<th><strong>Element Settings dialog</strong></th>
<th><strong>IFC Project Manager</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>management level</td>
<td>element-level only</td>
<td>project level</td>
</tr>
<tr>
<td>IFC data owner</td>
<td>– building elements</td>
<td>– building elements</td>
</tr>
<tr>
<td></td>
<td>– Zone (IfcSpace)</td>
<td>– spatial elements:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IfcProject</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IfcSite</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IfcBuilding</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Story (IfcBuildingStorey)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Zone (IfcSpace)</td>
</tr>
<tr>
<td></td>
<td>– IFC Assignments</td>
<td>– IFC Assignments</td>
</tr>
<tr>
<td></td>
<td>– IFC Type Products</td>
<td>– IFC Type Products</td>
</tr>
<tr>
<td></td>
<td>– IFC Containers</td>
<td>– IFC Containers</td>
</tr>
<tr>
<td>Functions</td>
<td>– collects and lists IFC data</td>
<td>– collects and lists IFC data</td>
</tr>
<tr>
<td></td>
<td>– enables you to create, edit and delete IFC data</td>
<td>– enables you to create, edit and delete IFC data</td>
</tr>
<tr>
<td></td>
<td>– enables you to use predefined rules</td>
<td>– enables you to use predefined rules</td>
</tr>
<tr>
<td></td>
<td>– filters Mapping properties</td>
<td>– filters Mapping properties</td>
</tr>
<tr>
<td></td>
<td>– filters only IFC data having values</td>
<td>– filters only IFC data having values</td>
</tr>
<tr>
<td></td>
<td>– navigates between the ARCHICAD model and the IFC model</td>
<td>– navigates between the ARCHICAD model and the IFC model</td>
</tr>
<tr>
<td></td>
<td>– displays Zone (IfcSpace) containment</td>
<td>– displays Zone (IfcSpace) containment</td>
</tr>
<tr>
<td></td>
<td>– enables you to assign elements directly to the IfcSite or IfcBuilding</td>
<td>– enables you to assign elements directly to the IfcSite or IfcBuilding</td>
</tr>
</tbody>
</table>
IFC Local Preferences

The settings defined at IFC Local Preferences (File > Interoperability > IFC) affect the way that IFC data are created and managed.

![IFC Local Preferences Dialog]

**IFC Interface language**

The language of the IFC standard/code is English, thus the default and recommended setting for the interface is English. In localized ARCHICAD versions, some standard IFC key words (such as IFC Entity, Property, Attribute names) may be shown in the local language, but this has no effect on the IFC export, just helps users comprehend IFC terms on the interface.

**Save Library Parts Generated During Import To**

Set the default location of imported Library Parts when opening or merging an IFC project. See [Library Parts Location](#).

**Express Data Manager (EDM) path**

The EDM (Express Data Manager) toolkit is the engine which creates an ARCHICAD model from the imported IFC model, and which also creates an IFC file out of the exported ARCHICAD model. The default engine is the recommended one, but you can use the Redefine option here to modify it as needed.
Define Element Criteria using IFC Data

Element criteria can include IFC data in the following functions:
- Find & Select
- Reserve Elements by Criteria (Teamwork)
- Interactive Schedule Schemes - list IFC data assigned to current project elements

In these dialog boxes:
1. When defining element criteria, choose “IFC Properties” from the “Add” pop-up list.

2. The Select IFC Properties dialog box appears.

Select IFC Properties
All IFC data added to project elements are listed here.

You can narrow the displayed data:
- Include IFC properties from the Active Preview Translator (as opposed to those currently used in the Project). For example, you may want to define a Find & Select criteria set that includes properties (e.g. Fire Rating) which may not yet exist in your project;
- Find only the IFC data of a chosen IFC Type; and/or
- Search for IFC data by typing any text string in the “Filter” list field.
3. Select the IFC data item to use as element criteria. Click Add.
   - Multiselection is available
   - If you select a Property Set in the list, then all of the Properties it contains are added to the criteria.
   - If you select an Attributes folder or a Classification References folder, then all items contained in the folder are added to the criteria

4. Define operators and values for the criteria according to their type (label, integer, boolean etc.)

   **Note:** In Find & Select: Get values for IFC data criteria from the model by applying the Pick Up Settings and Copy Settings tools to the owner element of the same IFC data type.)
Using IFC Properties in IES Schemes

- If you select a Property Set from the list, then all of the Properties it contains are added as fields.
- If you choose “IFC Assignment” as the parameter for Schedule Field, then the table will list (in non-editable form) all those IFC Assignments (their named branch) to which the element belongs. If an element has multiple Assignments, all of them will be listed, separated by a “;”.
- If you list an element’s “IFC Type Product” data, then the Schedule table will generate two columns: The “IFC Type Product - Type” (e.g. ‘IfcWallType’) and “IFC Type Product - Name”) (the Name Attribute of the IFC Type Product).

Use IFC Data Types as Element Criteria

From the criteria or field selection interface (e.g. the Find & Select dialog):
1. Click the Add button.
2. From the appearing Properties list, choose an IFC Data Type:
• ARCHICAD IFC ID (the Globalid IFC attribute automatically assigned by ARCHICAD to each element)
• External IFC ID (the Globalid IFC attribute assigned to each element upon IFC import)
• IFC Assignment, e.g. IFC Group.
• IFC Type (see below)
• IFC Type Product, e.g. IfcColumnType.

3. For IFC Type: the list is divided between all types available in the project (above the line) and all types that can be displayed and modeled in ARCHICAD (below the line).

The IFC Type list includes all so-called “parent” element type (these are collector entities that are above the other elements in the IFC entity hierarchy) - for example, IfcBuildingElement.

The following are examples of Find & Select possibilities using IFC data as criteria:
1. Find all elements that are members of any Assignment.
2. Find all elements of a particular IFC System.
3. Find all ARCHICAD Zones that have not yet been grouped into an IFC Zone.
Note: In Find and Select: the “Pick Up Settings” function does not work for IFC Assignment and IFC Type Product criteria.
IFC Translators: Overview

Importing and exporting model data using IFC takes place according to the settings of the IFC Translator you are using. An IFC Translator defines the rules for which elements should be converted and how they should be interpreted - whether in ARCHICAD or in the external application reading the IFC file.

Basic Workflow for Using IFC Translators

Important Note on Translators and Template Files

IFC Translators Dialog Box - Overview

Preview Translator

Managing Translators

Basic Workflow for Using IFC Translators

ARCHICAD provides predefined, factory-default IFC Translators whose settings are optimized for the particular import/export purpose.

Most ARCHICAD users doing IFC export and import do not have to adjust any Translator settings. All you have to do is select a predefined translator from the Open dialog box (when importing a model in IFC format), or from the Save As/Merge to IFC dialog box (when exporting an ARCHICAD model to IFC format).

See Export IFC Model from ARCHICAD and Import IFC Model to ARCHICAD.

Important Note on Translators and Template Files

- When you import an IFC project using Open or Hotlink IFC: You will choose an IFC Translator for Import from an external Template file, selected by you.
- When you import an IFC project using the Merge command: You will choose an IFC Translator for Import from the current host project.
IFC Translators Dialog Box - Overview

The IFC Translators dialog box (File > Interoperability > IFC > IFC Translators) allows you to view or modify Translator settings, or to create new Translators.

Translators are listed by name on the left side. The Translator name tells you what it is for: e.g. “Import from Modeling Applications” or “Export to Tekla Structures.” They are divided into Translators for Import and Translators for Export. The two groups of translators are not interchangeable, since they contain different settings.

- As needed, use the Search and Filter buttons at the top of the Translator list to locate a Translator.
  - The Filter button enables you to limit the list by IFC Schema: IFC2x3, or IFC4

See IFC Schema (Translators for Export only) for more information.

For complete details on all Translator settings, see the following sections:

Translators for Import (Detailed Settings)
Translators for Export (Detailed Settings)
Preview Translator

One of the Translators for Export is the Preview Translator, marked with the blue ARCHICAD icon:

The Preview Translator also provides default mapping definitions needed to work with IFC data in ARCHICAD. These essential mapping definitions are found in two presets of the Preview Translator:

- **Type Mapping for Export preset**
  The *Type Mapping preset* of the Preview Translator assigns an IFC Type to each exported ARCHICAD element. The IFC Type, in turn, affects which IFC properties are available to the element.  
  See also *Type Mapping for IFC Export*.

- **Property Mapping for Export preset (formerly IFC Scheme Settings)**
  Based on IFC Type, the *Property Mapping preset* of the Preview Translator provides the set of IFC Properties used for IFC data-related functions in ARCHICAD. For example, you can find/select/list IFC Properties in the following parts of the ARCHICAD interface:
  - criteria in Find & Select
  - criteria in Interactive Schedules
  - Labels (e.g. Classification and Properties Label, ID and Properties Label)
• IFC Project Manager
• Element Settings (Classification and Properties panel)

All these interfaces use the Property Mapping that is set in the Preview Translator.

See also Property Mapping for IFC Export

Use the Preview Translator:
- to export the model using the Properties visible in the current ARCHICAD model
- to see the IFC Properties in ARCHICAD as they are used in a particular IFC standard. For example, to work with the IFC Properties as defined by the COBie 2 Export standard for the US, go to the IFC Translators dialog box and switch the Preview Translator to “COBie 2 Export (US)”.

Note: The Property Mapping preset contains Translator-specific settings. In ARCHICAD versions prior to 21, these settings were project-specific, and managed in IFC Scheme Setup.

Set a Different Translator as the Preview Translator
1. Go to IFC Translators. (File > Interoperability > IFC)
2. Select a Translator for Export from the list.
3. Click Set Preview at the bottom of the dialog box.
4. The selected Translator is now the Preview Translator, marked with the blue ARCHICAD icon:
Managing Translators

Create New/Duplicate Translator

Do one of the following:
- Click the **New** button at bottom left, or
- Click the **Plus** button at the right of the Translators group (Import or Export).
Delete Translator
Select a Translator, then click the Delete button at bottom left.
- Multi-selection is not available.
- At least one Translator for Import and one Translator for Export must remain - you cannot delete the last one of either group.
  Note: If you delete the Preview Translator, you are prompted to select a different Translator for Export to serve as the Preview Translator. (See also Preview Translator, below.)

Cancel Changes in IFC Translators
In the IFC Translators dialog box, clicking Cancel will discard all changes you have made not only to the main dialog box, but also in the sub-dialogs (the specific Conversion Preset settings dialogs.)

Import Translators From ARCHICAD Project
To import Translators from another ARCHICAD project:
1. Click the import button at bottom left.
2. Browse for the desired file type: PLN, PLA, TPL, or XML (translator files from previous ARCHICAD versions).

Notes:
- Up to version 20, ARCHICAD saved IFC Translator files in XML format, in the Defaults/IFC Translators sub-folder of the ARCHICAD folder to which you installed the program.
• You can select any file of XML format here, but if you select an XML that is not an IFC Translator (for example, a Work Environment file), then you get a warning, and the import will not work.

3. Click **Open**. In the appearing dialog, select one or more IFC Translators to import from the selected project.

4. Click **Import**. In case your project already contains Translators of the same name as the imported ones, you are prompted to choose how to manage these (Replace, Import with new file name, or skip.)

**Importing Mapping Definitions**

Certain IFC Translator Mapping definitions (Type Mapping for Import/Export, and Property Mapping) are also imported to your project if you use the **Import BIM Content** or **Download BIM Content** commands.

*Watch the Video*

*Watch the Video*
Translators for Import (Detailed Settings)

An IFC Translator for Import defines the rules for handling model elements when importing an IFC-based file to ARCHICAD.  
For an overview of this topic, see Overview of IFC Import: Defining how IFC Data are Converted to ARCHICAD.

The IFC Translators dialog box (File > Interoperability > IFC > IFC Translators) allows you to view or modify Translator settings, or to create new Translators.

Select a Translator for Import from the list.

The selected Translator’s settings, divided into six Conversion Presets, are shown on the right side.
Working with Conversion Presets

For any category of Conversion Preset, click the dropdown list to view or select a different Preset. The Preset name gives you an idea of how it will affect the imported IFC model, if this Preset is used in a given IFC Translator for Import.

Choose a different preset from this list if needed.
To adjust settings or create a new preset, select **Edit/Create New Preset**, or click the three buttons at the right of the Preset.

The Preset dialog opens (for example, the Geometry Conversion for IFC Import).
For each of the IFC Import Preset dialogs, view the following:

- **Available Presets** for this Conversion process (e.g. Geometry Conversion)
  - **Settings** (this is where the import is defined in the greatest detail, for various data types, as defined for the currently selected preset at the top)
  - **Related Translators** (all the currently defined IFC Translators for Import which use this Preset)

All Settings of each type of Conversion Preset (used by IFC Translators for Import) are detailed in the following sections.

**Model Filter for IFC Import**
**Type Mapping for IFC Import**
**Property Mapping for IFC Import**
**Geometry Conversion for IFC Import**
**Layer Conversion for IFC Import**
**Material and Surface Conversion**
**Replace missing Renovation Status**
Model Filter for IFC Import

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Model Filter preset.

Show Model Filter on import

If this option is active, then - after you issue an Open or Merge IFC command - the Model Filter window will open.
This gives you the chance to overwrite, for the purposes of the current import process, the elements to be imported.
See Filter Model at Import (Secondary Filter).

Select 3D Elements to Import
– By Structural Function
  Use this as an additional (element-level) filter for import purposes, which takes into account the elements’ “LoadBearing” IFC Property at import.
  • “Load-Bearing elements only” means that only those elements whose IFC Property “LoadBearing Element” has a “True” value will be imported from the IFC file to ARCHICAD.

Notes:
• If no Structural Function classification has taken place in the ARCHICAD project, or if you have not finished the classifying process in ARCHICAD, then you should choose “All Elements” here: either of the other two settings (“Load-Bearing elements only” or “Non-Load-Bearing elements only”) can result an empty IFC file, or one that is missing elements you might need.
• IfcPile and IfcFooting entities are load-bearing structural elements by definition, although they have no “LoadBearing” property in the IFC2x3 Schema. They are always handled as load-bearing elements at import.

– By IFC Domain
  Use the IFC Domain to filter according to the following criteria for IFC import:
  • “All” includes all elements from the model
  • “Structural” includes only the structural building elements (IfcBuildingElement)
• “MEP” includes only the mechanical elements (IfcDistributionElement)
  See the exact composition of each Domain filter in the tree list below. Modifying this filter will create a “Custom” filter.

Select 2D Elements to Import
  - **IFC Grid**: During import, all IfcGrid elements of the IFC file will be imported and converted into grouped ARCHICAD Grid Elements.
  - **IFC Annotations**: Check this to import all IfcAnnotation-type elements (including exploded dimension elements) of the IFC file into ARCHICAD. They will be converted into 2D elements (texts and lines).
  - **IFC Door/Window Footprints**: During import, all generated doors and windows will be displayed in floor plan views with correct opening direction and sizes, based on their imported 2D symbols
Type Mapping for IFC Import

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Type Mapping preset. From this preset dialog, click **Map IFC Types for Import** to access the mapping definitions.

Use this chart to define how to classify IFC elements imported to ARCHICAD, based on their IFC Type.
At the top (“Target Classification System”), choose a Classification system in ARCHICAD whose definitions you want to use.
The IFC Type (far left column) is mapped to the Classification (far right column) as defined here. You can further narrow the mapping according to Predefined Types (if any) and User Defined Types.

“Any” means that the mapping does not take the Type definition into consideration when assigning the classification in ARCHICAD, even if the imported element has such a definition.

*Watch the Video*
Property Mapping for IFC Import

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Property Mapping preset.
Use this Conversion Preset to define how to handle the properties of IFC elements imported to ARCHICAD.

Topics in this Section
Choose Import Method
Using the Mapping Table
Assigning Property Values in ARCHICAD (Based on IFC Property Mapping)
Importing IFC Data to ARCHICAD Categories
Replace missing Renovation Status
Choose Import Method

Choose either **IFC Properties** or **ARCHICAD Properties**:

**Import as IFC Properties**
- This is the default option: ARCHICAD imports all properties of the imported IFC elements.
- These data will now be available as IFC Properties in various parts of the ARCHICAD interface, such as Find & Select and Scheme Settings of element lists. (This is how IFC properties were imported in earlier AC versions.)
- If you choose this, you do not have to use Property Mapping.
Import as ARCHICAD Properties

This option can be useful if you wish to make certain IFC property data available for ARCHICAD functions which use ARCHICAD Properties (but not IFC Properties). These functions include:

- Graphic Overrides
- Expression-defined Properties
- Collision Detection
- Autotext Labels

This option activates the mapping table. Use the table to define which IFC property values to import to which existing ARCHICAD Property.

- Each IFC Property in the list (defined using the first four columns from the left) is mapped to an ARCHICAD Property of the current project (far right column).
- No new ARCHICAD Properties are generated in the current project.
- IFC properties not listed in this mapping table are ignored during import.

Remember:

- The set of ARCHICAD Properties available to any element in ARCHICAD depends on the element's Classification.
• Each ARCHICAD Property has a default value (assigned in Property Manager).
• For elements imported from IFC, this mapping table lets you change their
  ARCHICAD Property value from default to a custom value, based on the applicable
  IFC data if available.
Using the Mapping Table

- Each row represents a mapping rule. You can sort the rows by clicking the column headers.
- Click on any rule, then use the list item controls to set data types or to enter custom text.
  - In each rule, use the four IFC data columns - Property, Property Set, Value Type, and Property Type - to narrow the set of IFC data to be considered. (These are all IFC standard definitions.)

- To populate the table with the IFC properties of an existing file, click Merge from IFC and browse for an IFC file. The file’s IFC properties and their data will be appended to the list as mapping rules.
- Use the **New, Duplicate** and **Delete** buttons to create and delete mapping rules. 
  *For details and examples, see* Assigning Property Values in ARCHICAD (Based on IFC Property Mapping)*

**Importing IFC Data to ARCHICAD Categories**

The following ARCHICAD Categories always use the corresponding data from imported elements. (These are Categories, rather than ARCHICAD Properties.) This data is filled in automatically, without reference to IFC Translator settings.
- Renovation Status
- Structural Function
- Position

![Classification and Properties](image)

However, it is also possible to map these IFC values manually, in the mapping table, to any ARCHICAD Property.

**Replace missing Renovation Status**

Choose a Renovation Status in ARCHICAD (New, Existing or Demolished) for imported elements that do not have an assigned renovation status in IFC.
Notes:

- Nearly every model exchange scenario will lack automatic mapping of renovation status. The reason is that the IFC2x3 standard has no standard format for renovation status, and so the various applications will export this data only as custom IFC properties.
- In model exchange with Revit, the ARCHICAD “Renovation Status” item is mapped to Revit’s “Phasing” item, provided that the IFC export and import on the Revit side is carried out using the [GRAPHISOFT ARCHICAD Connection Add-In](https://www.graphisoft.com/products/arcad/2016).
Assigning Property Values in ARCHICAD (Based on IFC Property Mapping)

For general information on setting up the Property Mapping preset: see Property Mapping for IFC Import.

For each imported element, ARCHICAD attempts to execute the applicable mapping rules. A mapping rule is applicable if the ARCHICAD Property is available to the element (based on its Classification).

The value of the mapped IFC property is assigned to the element’s corresponding ARCHICAD Property. (It is a custom value.)

Example: Mapping Rule Applied

We have set up a mapping rule in the Property Mapping for Import preset of the current IFC Translator. According to this rule, the IFC property called Example_A is mapped to the ARCHICAD Property called Product Info A.

A Column, with an IFC data called “Example_A”, is imported from an IFC file.

The mapping rule is successfully applied: the Column element generated during import has a property called Product Info A, which is assigned a custom value (in ARCHICAD
Element Settings, the Property value is displayed with the unlinked icon - it is no longer linked to its default value, set in Property Manager.)

Target ARCHICAD Property with Custom Value, after Element Import from IFC

Example: Non-Existent IFC Data
If a mapping rule refers to IFC property data that do not exist for the incoming element, then the element’s ARCHICAD Property value becomes Undefined.
Two mapping rules are shown. One of them refers to an IFC data (Example_C) that does not exist for the element being imported.
As a result, this mapping rule will assign the custom value of <Undefined> to the target ARCHICAD Property.

Incompatible Data Types
- If the mapped IFC element has a value, but it cannot be interpreted by the corresponding ARCHICAD Property (e.g. incompatible data types): no custom Property value is assigned. The element uses the ARCHICAD Property's default value.
Note on Data Types:

- IFC and ARCHICAD use different data type definitions: See Data Types for Properties in IFC and ARCHICAD. When you map an IFC Property to an ARCHICAD property, their data types do not necessarily have to coincide. ARCHICAD attempts to convert the data.
- If data conversion is not possible, the Session Report provides details on which elements' IFC data could not be converted.

Example

Two mapping rules are shown. One of these maps the “Example_A” IFC data (a string-type IfcLabel) to the Thermal Transmittance ARCHICAD Property, which is a String-type value. The mapping rule is successfully applied: the element generated during import shows a String-type custom value for the ARCHICAD Property of Thermal Transmittance.

The second mapping rule maps the “Example_A” IFC data to the Combustible ARCHICAD Property, which is a True/False type value. The data types do not match, so the mapping rule gets a Warning icon.

Mapping Rule to “Combustible” Property Referencing Incompatible Data Type

The targeted ARCHICAD Property does not get any custom value: it remains linked to its default value.
Property Mapping with Incompatible Data Types: No Change to ARCHICAD Property Value

- If no mapping rule applies to an element’s given Property, then no custom Property value is assigned. The element uses the ARCHICAD Property’s default value.

Conflicting Mapping Rules

The mapping table may include several IFC Properties mapped to the same single ARCHICAD Property. In this case, ARCHICAD will use the most specific rule. (The order in which the rules appear in the mapping table does not matter.)

In case of two or more equally specific mapping rules: the rules are ignored, and no mapping takes place.

A rule becomes more specific as its IFC data properties are more narrowly defined. (For example, IFC PropertySet data set to “Any” is less specific than if it is a defined IFC PropertySet.) Within a mapping rule, each field to the right further narrows its definition.

Here, two IFC data (Example_A and Example_C) are mapped to the same ARCHICAD Property. In this case, the more specific rule is automatically applied. Example_C is more specific, since it is narrowed down at the level of IFC PropertySet.

In the next example:
Several Thickness-related IFC Properties are mapped to a single Thickness Property in ARCHICAD. If an imported IFC element comes with multiple Thickness properties, then ARCHICAD has no way of determining which Property value to use in ARCHICAD. Thus, the rules are ignored for this imported element, and its ARCHICAD Property value remains the default one.
Geometry Conversion for IFC Import

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Geometry Conversion preset.
Use this dialog box to define how to convert the geometry of IFC elements imported to ARCHICAD.

Building Elements
Convert to:
- Construction elements, otherwise Objects
- Construction elements, otherwise Morphs

With either of these options, IFC elements whose supertype is IfcBuilding (IfcWall, IfcColumn, IfcBeam, etc.) are imported as editable ARCHICAD elements ("Construction elements": Wall, Column, Beam, etc.)

The advantage of converting the imported elements to AC tool-based construction elements is that they remain parametric, and ARCHICAD functions (such as automatic intersections) will apply to them.

Even if you choose the “Construction element” option, some elements cannot be imported in this form: such as non-extruded (BREP geometry) elements, or elements having no counterpart in ARCHICAD.

For such elements, you can choose to convert them as either an editable Morph or an Object ("otherwise Objects/otherwise Morphs").

- Morphs
- Objects
  - Conversion of elements to Morphs or Objects guarantees perfect geometry import.
  - The resulting Morphs will be editable.
  - The resulting Objects will be Library Parts, whose subtype will match the IFC entity type: for example, an IfcColumn converted to an ARCHICAD Object will have the subtype “Column”.

**Distribution elements**

This option applies to imported elements whose domain is MEP (IfcDistributionElement).

These elements can be converted to one of three results:

- Morphs
- Objects
  - Conversion of elements to Morphs or Objects guarantees perfect geometry import.
  - The resulting Morphs will be editable.
  - The resulting Objects will be Library Parts, whose subtype will match the IFC entity type: for example, an IfcColumn converted to an ARCHICAD Object will have the subtype “Column”.

- MEP Elements: If GRAPHISOFT MEP Modeler Add-On has been installed, this option generates parametric MEP elements. Even if you choose this option, the MEP IFC model might not contain sufficient data to generate the parameters, in which case non-parametric MEP Equipment elements will be generated, or - in case of limited data - Objects will be generated.

**Other elements**

This option defines how to convert elements that are neither building elements nor distribution elements (such as furnishing and transportation elements).

- Morphs
- **Objects**
  - Conversion of elements to Morphs or Objects guarantees perfect geometry import.
  - The resulting Morphs will be editable.
  - The resulting Objects will be Library Parts, whose subtype will match the IFC entity type: for example, an IfcColumn converted to an ARCHICAD Object will have the subtype “Column”.

**IFC Site geometry**
Check this box if you want to include the geometry of the imported IfcSite.
Define whether the converted element should be an editable Morph or an Object. (IfcSite geometry cannot be converted to an ARCHICAD Mesh.)

**Define how to position the imported IFC model**
Match ARCHICAD Project Origin with:
- IFC Site Location (Recommended)
- IFC Global Origin

**Import Unnamed IFC Profiles**
Choose how to handle unnamed IFC profiles imported to ARCHICAD:
- Custom Profiles (this option does not create any new attributes in the ARCHICAD project)
- Profile Attributes (new Profile attributes are added to the ARCHICAD project)

**Notes on Geometry Conversion**
- To optimize the management of shared geometry, ARCHICAD creates as few geometric elements (when generating Morphs) or as few Library Parts (when generating Objects) as possible.
- Objects can be placed in the project’s Embedded Library, or else saved to a given linked library ([see IFC Local Preferences](#)).
- Some IFC models may contain elements with special geometry which cannot be converted to Morphs, even if you choose the Morph conversion option. In this case, ARCHICAD will generate Objects, to achieve perfect geometry import.
- Imported IfcSpace elements will always be generated as ARCHICAD Zones, which will always retain the imported elements’ original geometry.
Layer Conversion for IFC Import

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Layer Conversion preset.
Use this dialog to define the method for placing the imported elements onto ARCHICAD layers. You can choose between three different methods:

- Place all elements on a single new Layer
  Imported elements will be placed onto a newly created, single layer that you define (such as the “IFC Import” layer). (Enter the desired text in the input field.) Original layer names of the IFC model will be lost.
Create new Layers to keep original Layer structure

ARCHICAD will create layers using the original layer names (e.g. IfcPresentationLayerAssignment) of the IFC model, and will place the imported elements onto these layers.

- **Extend original Layer names with suffix:** Check this to add a custom extension (such as “IFC Model”) to each Layer name. (Enter the desired text in the input field). The advantage is that you will be able to sort the layers by extension in ARCHICAD’s Layer Settings dialog box.

Use existing ARCHICAD Layers

From the Default Layer popup, choose an existing layer from the ARCHICAD project on which to place imported elements.
Override default Layer with mapping
Check this box to map individual layers manually, instead of using the default Layer assigned from the pop-up.

Click **Merge from IFC** to browse for the IFC model and append its IFC Layer names to the list in the Mapping dialog.
Alternatively, click **New** to add an IFC Layer name manually.

Assign Layer to SEO Operators Used to Generate Openings
Some imported openings can be created in ARCHICAD only by using Solid Element Operations. In such cases, ARCHICAD uses operator elements to generate the openings automatically via SEO.
At IFC import, you can define the layer settings of these SEO operator elements:

- **Create new dedicated Layer**
- **Use existing ARCHICAD Layer**
  
  **Note:** If you move any of the target elements, make sure that the operator elements’ layer is shown, and move the target and operator elements together: do this to avoid modifying the original geometry of the imported elements.

**Notes on Layer Conversion:**

- The import process automatically sets an intersection group number for all imported layers, and this number will be different from the current project layers' intersection group number. This difference ensures that the elements on the imported layers will not intersect with the existing project elements.

- If the elements have been converted to their counterpart ARCHICAD tool-based construction elements (that is, they have not been converted to Objects or Morphs; see *Geometry Conversion for IFC Import* above), then elements on identical layers might have their geometries modified due to automatic intersections. If you want to avoid this, set the intersection group number to 0.

- If layers of the same name already exist in ARCHICAD, no new layers are created; the imported elements are placed onto the corresponding, existing ARCHICAD layers.
Material and Surface Conversion

File > Interoperability > IFC > IFC Translators
Choose a Translator for Import and open the Material and Surface Conversion preset. Use this dialog to choose how to assign ARCHICAD Building Materials to imported IFC model elements.

There are two import methods:

Method 1: Replace IFC Materials with existing ARCHICAD Building Materials
With this method, a single ARCHICAD Building Material is assigned to all imported IFC elements. Choose this default Building Material from the pop-up below. No new Building Materials are generated.
If needed, you can override this default definition by using Material Mapping: see Override default Material with mapping, below.
Method 2: Create ARCHICAD Attributes from IFC Materials

For each IFC Material, a new ARCHICAD Building Material will be created: the default Building material chosen below will be duplicated.

The new Building material:
− is named using the IFC Material’s Name parameter
− is assigned a color corresponding to the IFC Material Color parameter

Override default Material with mapping

Check this box to map individual materials manually, instead of using the default Building Material assigned from the pop-up.

Click Merge from IFC to browse for the IFC model and append its IFC Material names to the list in the Mapping dialog.

Alternatively, click New to add an IFC Material name manually.

Note:
• Some of the default IFC Translators for Import include predefined mapping rules, whose settings you are free to expand or edit. It is recommended to duplicate the default translator before modifying it.
• You cannot import or export these mapping tables as separate files (e.g. xml); you must import/export them together with entire translator file itself.
Override Material colors with IFC element geometry surfaces

IFC elements in IFC models can have two colors: a material color and an additional color for the surface geometry color.

If you check this **Override Material colors** box, ARCHICAD will create Surface attributes using the color assigned to the IFC element’s surface geometry.

To check and modify the resulting surface overrides in ARCHICAD, view the Model panel of the respective Element Settings dialog box.
Translators for Export (Detailed Settings)

An IFC Translator for Export defines the rules for handling model elements exported from ARCHICAD to an IFC format.

For an overview of this topic, see IFC Translators: Overview.

The IFC Translators dialog box (File > Interoperability > IFC > IFC Translators) allows you to view or modify Translator settings, or to create new Translators.

Select a Translator for Export from the list.

The selected Translator’s settings, divided into six Conversion Presets, are shown on the right side.

One of the Translators for Export is the Preview Translator. The Preview Translator exists to provide default mapping definitions needed to work with IFC data in ARCHICAD.

For details, see Preview Translator.

The IFC Schema and Model View Definition categories help in setting up presets that are compatible with particular standards (see details below).
IFC Schema (Translators for Export only)

An IFC Schema is a particular version of the IFC standard. ARCHICAD Translators can support either Schema IFC2x3 (recommended) or IFC4.

Note: IFC2x3 is recommended - this is the most widely used version. Choose IFC4 only if you are certain that it is supported by the application that will receive IFC data using this Translator.

Model View Definition (Translators for Export only)

A Model View Definition (MVD) is a recommendation for which data and elements the IFC model should include, depending on the purpose of the model exchange. If your exported IFC model must conform to a predefined standard MVD, choose that MVD from the list.

Note: Available MVD’s depend upon the IFC Schema chosen above: IFC2x3 or IFC4. For a more detailed explanation of MVD’s and their characteristics, see Model View Definitions.

Once you choose an MVD, then certain Translator for Export settings must conform to the requirements of that MVD. If you change a Translator setting so that it no longer conforms to the selected MVD’s requirements, then the Translator becomes invalid, and you get a warning in the dialog box. The problematic setting is also marked:

Working with Conversion Presets

For any category of Conversion Preset, click the dropdown list to view or select a different Preset. The Preset name gives you an idea of how it will affect the exported IFC model, if this Preset is used in a given IFC Translator for Export.
Choose a different preset from this list if needed. To adjust settings or create a new preset, select Edit/Create New Preset, or click the three buttons at the right of the Preset.

The Preset dialog opens (for example, the Geometry Conversion for IFC Export).
For each of the IFC Export Preset dialogs, view the following:

- **Available Presets** for this Conversion process (e.g. Geometry Conversion)
- **Settings** (this is where the export is defined in the greatest detail, for various data types, as defined for the currently selected preset at the top)
- **Compatibility**: Feedback on whether the current settings of this preset conform to particular Model View Definitions.

Click the **Info** button to see the settings conflicts, if any. (If the current Translator for Export does not use that particular MVD, then this conflict need not be a problem.) To ensure compatibility with the MVD, you can adjust the settings as shown in the Info dialog, or just click the **Override Settings** button to solve the issue.

- **Related Translators** (all the currently defined IFC Translators for Export which use this Preset)

All Settings of each type of Conversion Preset (used by IFC Translators for Export) are detailed in the following sections.
Model Filter for IFC Export
Type Mapping for IFC Export
Geometry Conversion for IFC Export
Property Mapping for IFC Export
Data Conversion for IFC Export
IFC Global Unique Identifier Attribute (GlobalId)
Unit Conversion for IFC Export
Model Filter for IFC Export

File > Interoperability > IFC > IFC Translators
Choose a Translator for Export and open the Model Filter preset.

Select 3D Elements to Export
This filter defines which ARCHICAD 3D elements should be exported to IFC. You can filter by the elements’ Structural Function and/or by their IFC Domain.

- By Structural Function
  This is an additional filter to the IFC Domain filter set below.
  - This filter considers the ARCHICAD element’s “Structural Function” category: Either Load-Bearing or Non-Load Bearing. This is set for each element in its Classification and Properties panel of Element Settings.
  - “Load-Bearing elements only” means that only those elements classified as “Load-Bearing Element” (plus ARCHICAD Zones) will be exported from ARCHICAD to IFC.
- By IFC Domain
Note: An element’s IFC Domain depends on its Type Mapping preset.
- “All” includes all elements from the model
- “Structural” includes only the structural building elements
- “MEP” includes only the mechanical elements (IfcDistributionElement).
See the exact composition of each Domain filter in the tree list below. Modifying this filter will create a “Custom” filter.

Select 2D Elements to Export
- **Grid System and Elements:** Check this to include the Grid Elements and the grid members of Grid Systems in the exported file.
  Grid elements will show up in the IFC structure as IfcGrid.
- **Lines, Texts, Labels, Fills:** Check this to export these 2D elements, plus all dimension types.
  - 2D elements will show up in the IFC structure as IfcAnnotation.
  - Dimensions will be exploded into lines and texts, since the IFC2x3 standard documentation does not include a dimension element.
• The inclusion of 2D elements in the exported file is also affected by the “Elements to Export” filter at “IFC Save Options”: if a 3D view is currently active, the 2D elements can be included only if the “Entire project” option is selected in that filter. *(See Filter Model at Export.)*

• IFC4 Reference View does not allow annotations. To ensure compatibility for IFC4 Reference View, leave this box unchecked.

  – **Door/Window 2D Views:** Check this box to include the 2D symbols of doors and windows in the export process, in addition to 3D model geometry. This is handy if the recipient program recognizes these data and can correctly display, for example, the door opening directions.
Type Mapping for IFC Export

File > Interoperability > IFC > IFC Translators
Choose a Translator for Export and open the Type Mapping preset.
From this preset dialog, click the Map IFC Types for Export to access the mapping definitions.

Topics in this Section
About Type Mapping for Export
Mapping by Element Type
Mapping by Classification

About Type Mapping for Export
When a model is exported to IFC format, every one of its elements is assigned an IFC Type.
This dialog defines how to assigns an IFC Type to each exported ARCHICAD element.
There are two ways to take care of Type Mapping for IFC Export:
- By Element Type
- By Classification
Each is described below.

Mapping by Element Type
Assigns each ARCHICAD Element Type automatically to a default, basic IFC Type, corresponding to its ARCHICAD tool or (for GDL objects) to its Object Subtype.
If you choose this method, no further manual mapping is needed. The rest of the dialog controls are inactive.
For more details, see [Built-in IFC Type Mapping for ARCHICAD](#).

**Mapping by Classification**
Maps each ARCHICAD Classification to an IFC Type, Type Product, and/or Predefined Type. This method allows for flexible and detailed IFC Type classification, according to specific IFC standards.
To use this method:

1. Select Mapping by Classification.

2. Choose a Classification System (among those available in the ARCHICAD project). The Classifications of the selected System are now listed on the left side of the dialog.

3. Set the Filter to display IFC Type definitions by the IFC4 Schema, the IFC2x3 Schema, or both. This is relevant for fixing erroneous mapping definitions (see How to Fix Error Warnings in the Type Mapping Dialog). By default, the filter automatically corresponding to the IFC Schema of the current preset.

Now you can map the Classifications on the left to the IFC Type definitions on the right, as detailed below (By Parent and Custom).

**Classification Mapping by Parent**

Maps the selected Classification to the same IFC Type as its parent Classification. For such Classifications (shown in blue), you don't have to define the IFC Type, because it will automatically get the same one as its parent.
Custom Classification Mapping
Maps the Classification to an **IFC Type** and **IFC Type Product** selected by you. This assigns more specific IFC Type definitions to the exported elements.

For example, here an element is classified in ARCHICAD as Flow Instrument, and it is mapped to the IFC Type and IFC Type Product assignments as shown: just click the popups to access a list of valid definitions.
Map to IFC Type and IFC Type Product

If the chosen IFC Type or IFC Type Product have Predefined Types, you can map those too.

Here, the Flow element’s Type Product is assigned the Predefined Type of PRESSUREGAUGE:

Choose a Predefined Type
**User Defined Type**
If the list of Predefined Types does not contain what you need, choose USERDEFINED and then enter the desired value in the text field below.

**Synchronize Predefined Type Values**
In most cases, the Predefined Types for IFC Type and IFC Type Product should be identical. To speed things up, the **Synchronize** checkbox is on by default:

![Synchronize Predefined Type Values](image)

**Invalid Predefined Types**
If a Classification element is mapped with a Predefined Type that is not available in the current Schema (e.g. the MOLDING value is available in IFC4 but not IFC2x3), then this value will be grayed out, and will not be exported. (The Translator preset will still be valid.)
Reset Mapping
Click this button to undo the mapping definitions made since opening the dialog.

Note: The Type Mapping preset of the Preview Translator has an additional function: to define the default IFC Type classification of elements in the current ARCHICAD project.

See also Preview Translator.

Related Topics
IFC Type
How to Fix Error Warnings in the Type Mapping Dialog
How to Fix Error Warnings in the Type Mapping Dialog

ARCHICAD 23 includes two Presets for Type Mapping for IFC Export. Each Preset is optimized for a supported IFC Schema: IFC2x3 or IFC4.

If you use the predefined Presets, as shown in the images below, the mapping will be correct.

If you customize the Type Mapping preset or change the Schema definition, this may result in mapping definitions that are obsolete or incorrect, because the IFC type definitions differ somewhat for IFC2x3 and IFC4.

ARCHICAD’s IFC Translators dialog and the Type Mapping subdialog will alert you about any incompatible Type Mapping definitions, and help you fix them.
Here, you have a custom Type Mapping Preset that is supposed to be compatible with the IFC4 Schema. But the Compatibility panel indicates a problem:

Click the three-dot button to open the Type Mapping Preset dialog. Here, too, the problem is indicated.
Click the Info button to find out more. Now the Compatibility Info dialog lists the problematic mapping items (here: Footing, Pile, and Ramp).

Click **OK** to return to the main dialog, then click to open **Map IFC Types for Export** dialog...
In the **Map IFC Types for Export** dialog, set the filter to “Show IFC Entities for IFC4 Schema,” as shown in the image below.

This will set up the dialog box so that you are forced to choose mapping definitions compatible with IFC4.

In the left-hand tree view, you can see the Classification items that have errors: they are marked with warning triangles. These items were probably mapped correctly for IFC2x3,
but since naming standards have changed or been expanded, you have to re-map these items to use the corresponding new terms for IFC4. This will be easy.

1. Select the problem Classification item (e.g. Footing).
   Its mapping definitions are on the right. The IFC Type is okay, but the IFC Type Product is missing.

2. Click the IFC Type Product pop-up to see compatible mapping choices. Select one and click Choose.
The mapping issue for the Footing item is solved.
Repeat this re-mapping for each of the problem elements to ensure that your Type Mapping preset is compatible with IFC4.
Geometry Conversion for IFC Export

File > Interoperability > IFC > IFC Translators
Choose a Translator for Export and open the Geometry Conversion preset.

These settings define how to convert the geometry of ARCHICAD elements exported to IFC.

The conversion settings are divided into categories:

Conversion of ARCHICAD Elements
Hierarchical ARCHICAD Elements
IFC Schema-Related Options
Composite Structures and Complex Profiles
Conversion of ARCHICAD Elements

Export only geometries which “Participate in Collision Detection”

Exports only elements whose ARCHICAD Building Material includes the “Participates in Collision Detection” option ON. (This is set at Options > Element Attributes > Building Materials > Properties).

Use this option to export composite elements and complex profiles, which don’t have solid geometries, as real air gaps. This way, MEP engineers (who receive the ARCHICAD IFC file) can place pipes in the gaps without collision detection; only element parts which have real geometry will participate in collision detection.

Export Bounding Box

Exports the dimensions of the building elements’ bounding box.

Export Geometry of IFC Type Products

Assigns a representative geometry to each Type Product. (This option is required for Concept Design BIM 2010.)

Each type (e.g. IfcFurnishingElementType) will use a representative geometry of the elements that belong to it (e.g. IfcFurnishingElement).

Export gross geometry of elements (Export holes separately)

Elements containing Doors, Windows and/or Openings are exported with their gross geometry. For example, a host Wall is exported with its gross geometry, without considering the hole created by a window.

Use this option to ensure accurate cost calculation using the IFC model, where the opening geometry will be considered separately.
**Note:** Openings are exported by checking IfcOpeningElement in the Model Filter for IFC Export. This is generally checked by default.

If the **Export gross geometry** option is *unchecked*, then elements cannot be created using extrusion. In this case, extruded elements with holes are exported as BREP!

**Use BREP geometry in current color for all elements**

All model elements are exported using BREP (Boundary Representation) geometry. BREP is precise but non-parametric geometry.

The elements will be exported in the color displayed in the current ARCHICAD view, including colors defined by Graphic Overrides, Renovation Status, and Mark-Up Corrections or Highlights.

If you do not check this box, you still have the option to set BREP or other conversion options for the following four element categories:

**Elements in Solid Element Operations**

- **Extruded/revolved:** This method can retain the elements’ parameter values (such as thickness, height, location of reference line or edge). The skin structure of composite materials cannot be fully preserved because of the IFC standard's limitations. Certain specialized sections are not retained.
  
  This is the format usually supported by static analysis programs, in which element parameters are important, but their special cut angles (such as the slanted edge of a slab) are not important.

- **BREP:** This method provides the most exact reproduction of element geometry, together with its specialized sections and connections. However, the element’s parameters are lost, and BREP (Boundary Representation) elements are transformed into non-editable elements. This method is useful in the “reference model” workflow.
Elements with junctions

- **Extruded/Revolved without junctions:** Elements are exported without the priority-based intersections, resulting in a faster export process. This option is recommended for structural analysis programs, for which the elements’ reference lines/surface information is sufficient, and detailed intersections are not required.

- **BREP:** Elements are exported together their junctions, for precise geometry.

The difference in the two export methods is illustrated here:

![Extruded geometry](image1)

![Precise geometry (BREP)](image2)

---

Slabs with slanted edge(s)

- **Extruded:** Slabs will be exported with vertical edges (even though their original geometry included a slanted edge.)

- **BREP:** Slabs will be exported with precise geometry, recreating the slanted slab edges.

![Extruded geometry](image3)

![Precise geometry (BREP)](image4)
Note on Export of IFC Site Geometry:
As of ARCHICAD 23, all elements that are IFC Site Geometry are exported to IFC as solid bodies.
ARCHICAD elements are IFC Sites if they are:
- Classified using “IfcSite” as their IFC Type, or
- Saved as Objects having the Subtype “IFC Site”

Match IFC Site location with:
Define location of the IFC Site entity (its coordinate system), if a Survey Point has been defined in ARCHICAD. *(See also Using Survey Point in ARCHICAD, below.)*

- **ARCHICAD Project Origin:** Locate the IFC Site entity at the Project Origin if you are working close to the ARCHICAD Project Origin, yet still wish to define model coordinates relative to a national datum (using the Survey Point). This way, a far offset is stored in the IFC file not as part of the element coordinates, but rather generally. See the following illustration:

- **ARCHICAD Survey Point position:** Locate the IFC Site entity at the position of the Survey Point. Use this if you are working at a long distance from the Project Origin, yet you don't want large offsets to be present in the IFC file (usually with legacy models). See the following illustration:
Notes:

• If the ARCHICAD project does not contain a Survey Point, then the IFC model’s global coordinate system origin and the IFC Site Location will be the ARCHICAD Project Origin.
• If the ARCHICAD project contains multiple Survey Points (though it is recommended to use just one), then the first placed Survey Point will be used. (A warning will alert you to this.)
• The program will consider the Survey Point even if it is not visible in the exported view (i.e. if it is on a hidden layer)!

Using Survey Point in ARCHICAD

ARCHICAD has a Survey Point object, which can be used as common reference point to facilitate coordination of models from different programs. In some countries, use of a particular reference point is a standard requirement when defining the project.

The position and rotation of the Survey Point defines the global coordinate system (X=0, Y=0, Z=0) of the IFC model. When defining this point position in ARCHICAD, it is recommended to consider the True North direction (use the default “Follow Project North” parameter). At IFC export, this parameter defines the direction of the Y axis in the global coordinate system.
Notes:

- In ARCHICAD, True North is defined by Project North (Options > Project Preferences > Project Location)
- The Survey Point is always created at IFC Open. In case of Merge IFC, the model is imported to be aligned to the host file’s Survey Point.
- To assign geographic property data, use the Survey Point’s Referencing Map page, or via IFC import. These properties can be shared with any project participants via IFC.
  - The Geodetic Datum and Map Projection fields must be filled out (data is required)
  - Geo Referencing data are exported as Property data only. They do not affect the model’s actual location.
  - Export via IFC 2x3: The data is exported as two new IFC Property Sets.
  - Export via IFC4: New IFC entities are created: IFC Map Conversion, and IFC Projected CRS.

For more information on Survey Point in ARCHICAD, see the Help Center article at: http://helpcenter.graphisoft.com/tips/open-bim/survey-point-is-now-supported-at-ifc-importexport/
Mapping IFC Location Data From ARCHICAD and Revit

<table>
<thead>
<tr>
<th>IFC</th>
<th>ARCHICAD 20 and up</th>
<th>Revit</th>
</tr>
</thead>
<tbody>
<tr>
<td>IFC Global Origin</td>
<td>Survey Point</td>
<td>Survey Point</td>
</tr>
<tr>
<td>Position of IfcSite entity</td>
<td>Project Origin</td>
<td>Project Base Point</td>
</tr>
</tbody>
</table>

Hierarchical ARCHICAD Elements

Choose a conversion option for each type of hierarchical element: Curtain Walls, Stairs, Railings.

- **Convert to single element**: The hierarchical element is exported as a single IFC entity, which contains within itself the geometry of all its sub-elements. The hierarchical nature of the original element (e.g. Stair, with all its separate sub-components) is thus lost.
- **Keep hierarchy**: Retain the original element's hierarchical structure, including sub-elements.

See also [Exporting Hierarchical Elements from ARCHICAD as IFC Containers](#).

IFC Schema-Related Options

Material preservation mode (IFC2x3 only)

Use this control to define whether and how to explode complex elements into Building Element Parts. This choice depends on whether you need to retain the material definitions of the components.

Choose one of the following Material preservation modes:

- **Never explode elements**. Material preservation is not guaranteed.
  - This is the default option: complex elements (composites and Profiles) are not exploded, because doing so multiplies the number of Building Element parts in IFC.
- **Explode only when necessary to preserve materials**. The program will explode an element only if that is the only way to preserve its material definition.
- **Explode all elements into parts, preserve materials**. All complex elements are exploded into parts, and material preservation is guaranteed.

Notes:
- These Material preservation options are relevant for IFC2x3 only.
- For IFC4, use the control below: see [Split Complex Building Elements into parts](#).

Composite Structures and Complex Profiles

Split Complex Building Elements into parts

Use this control to split complex elements into Building Element Parts. This option enables you to comply with IFC4 Reference View. Material definitions are not affected by this
option (IFC4 retains material definitions irrespective of whether complex elements are split.)

This option enables composite elements and Complex Profiles to be split into so-called “Building Element Parts”. With this option, the receiving Structural Engineer will know that a composite Wall includes an air gap component.

If you check the box:

- the tree structure below is editable: you can choose specific element types to be split into parts. (The unchecked element types will not be split up.)

If the box is not checked: no complex elements will be split.
Property Mapping for IFC Export

File > Interoperability > IFC > IFC Translators
Choose a Translator for Export and open the Property Mapping preset. From this preset dialog, click the Map IFC Properties for Export to access the mapping definitions.

These mappings define the IFC properties assigned to elements when exported from ARCHICAD.
Tree list of IFC Entities

IFC Entities are listed in the tree at left.

- Use the pop-ups if needed to filter the tree list:
  - filter by Schema (IFC2x3 or IFC4)
    - **Note:** A parent entity, if it can be used for property mapping, will be displayed even if it does not belong to the Schema in the current filter
  - filter by domain (Structural or MEP). For example, the Structural domain contains the building element (IfcBuildingElement) types (IfcBeam, IfcColumn, etc.) while the MEP domain contains the IfcDistribution types.
  - filter by IFC Assignment types, IFC Type Objects, or IFC Spatial element types (IfcSpatialStructureElements: IfcSite, IfcBuilding, IfcBuildingStorey and IfcSpace).
Filter IFC Entities in Tree List

**Note:** IFC Entities in parentheses are necessary to the IFC Schema, but have no ARCHICAD elements assigned to them directly.

**List of IFC Properties**
The IFC Properties of each selected entity are listed in the **IFC Properties** column.
- Property data assigned to a parent element (such as IfcElement) are automatically assigned to all its child elements (e.g. IfcBeam, IfcColumn, IfcSlab, IfcWall, etc.)

- **BOLD TYPE:** IFC Entities which have property set data assigned to them are shown in **BOLD**.

- **BLUE TYPE:** Properties of a child element are shown in blue type. You can see its parent type name in parentheses.

- Chain icon: Indicates that the property has a mapping rule. View its mapping rule at the right side of the dialog box.

- **X:** Delete any data item by clicking the red X. Attributes cannot be deleted.
Property assignment can be modified only at the parent level. Thus, to create a common property for all building elements, you don't have to create it for every single building element type (IfcWall, IfcColumn, IfcSlab, etc.): instead, create it once at a higher level (e.g. at IfcElement).
A mapping rule can be assigned at different levels. For example, you can apply a rule at the IfcElement level, which will be applicable to all of its child elements (e.g. IfcBeam). A property's *mapping rule* can be redefined at the child level, too.

**Add New Property/Classification Reference**

To add a new IFC Property or Classification Reference data to the currently selected entity, do one or both of the following:

- Click the **New** button to create a New Property or Classification.

  The same function is available in the IFC Project Manager and Element Settings dialog boxes.

  *See Create New, Custom IFC Property.*

**Import from Current Project**

Click this to add all the custom IFC Property Sets and Properties of the current project (defined in either IFC Project Manager or Element Settings) to the Property Mapping preset.

  **Note:** If a custom property assigned to an IFC element type (for example IfcWall) is not yet available in the current project, it is not displayed in the IFC management dialogs until one instance of the type has been defined in the model.

**Clear All Settings**

Delete the entire contents (mapping rules, Properties and Classification References) of the current Property Mapping Preset.

**Related Topics**

*Predefined Property Mapping (Export ARCHICAD to IFC)*

*Preview Translator*
How to create a Mapping Rule

1. Select the IFC Property which you would like to map. Data in italic type cannot be mapped.
2. Click on the “New Rule” button. The “Empty Rule” field appears.
3. From the “Add Content” drop-down button, select a Rule Content type:
   • Parameters & Properties (as the Interactive Element Schedule)
   • Library Part Parameters (as the Interactive Element Schedule)
   • Static Text

4. Add fields to the rules. Fields can have types: e.g. “Thickness” is length measure, “Area” is area measure, “Library Part Name” is string. If a rule contains more than one field, the fields are always a concatenation of fields converted to a string. Conversion is based on calculation units (Project Preferences > Calculation Units & Rules). Fields implicitly contain filters: for example, the Wall’s “Height” field can only be evaluated for Wall elements. “General” fields are listed at tool levels too and are valid only for that specific tool.
5. Library Part Parameters can be set in two ways:
   • **Library Part dependent**: The selected Library Part parameter will be in effect only for elements that contain this parameter. If the Library Part parameter was defined at the Object subtype level, then the parameter mapping will take place for the child elements, too. For example, if we are mapping the “gs_list_cost” variable parameter of the GS Door Object subtype, then the mapping will be in effect for all Doors (and
ifcDoors) which are child Library Part elements of the GS Door (such as Door, Double Door, Metal Door, etc.) See examples below.

- **Library Part independent**: the parameter variable (e.g. “gs_list_cost”) will be in effect for the mapping, regardless of which Library Part it was chosen from. For example, if you select the “gs_list_cost” parameter of the Double Door for mapping as a Library Part Independent parameter, then the mapping will take place for every Door that accesses the “gs_list_cost” parameter. If this door parameter is used for mapping at the IfcElement level, then it will be mapping for all IFC entities which are child entities of the IfcElement and which include the “gs_list_cost” parameter (such as Furnishing elements, e.g. Armchair and Chair). See examples below.

**Notes:**

- If the Property Mapping Preset contains a mapping rule involving a Library Part parameter which is not loaded in the project, then the rule, the mapped IFC data, and the mapped IFC Entity data are all shown in red.
- You can assign multiple rules to a single property. This is useful, for example, if several tools will generate the same IFC element type. Rules will be applied in the order in which they appear on the user interface: the first valid rule will be applied.
• String-type rules can be split. Separator type, separator position and split type give you several ways to split a string. For example, use a split to cut out a particular fragment of a Library Part Name.

Related Topic

Examples of Property Mapping Rules
Examples of Property Mapping Rules

Example 1
Map the user-defined “Acoustic Rating” property (Options > Property Manager) to the “AcousticRating” property defined for the IfcWall.

Example 2
Map the “Fire Resistance Rating” parameter of windows to the “FireRating” property defined for the IfcWindow.
Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.

---

Example 3

Define the “Name” Attribute of IfcWall elements using a combination of Wall “ID” and “Building Material/Composite” Name.

Example 4: Mapping Rule by IFC Type Product

You can apply data mapping rules to the IFC data of IFC Type Product elements. For example, generate the names of Door types (Name Attribute of IfcDoorStyle) from the combination of the Library Part Name, the Width and Height parameters of a Door.

Define the “Name” Attribute for IfcDoorStyle by using a fragment of the Door “Library Part name” + static text “-” + “Width” + static text “X” + “Height”.
This rule overwrites the default IfcDoorStyle creation rule (see IFC Type Product) with new IfcDoorStyle names (you can double-check the result in the IFC Project Manager).

Example 5
Define the “Cost” Property for IfcDoor as Library Part dependent parameter. For mapping, choose the “gs_list_cost” parameter of the “GS Door” Library Part.
To find this parameter, go to the Add Content drop-down button and choose Library Part parameters. From the appearing dialog box, search for the gs_list_cost parameter as shown:

![Image of ADDITIONAL OBJECT PARAMETERS dialog box]

The mapping rule is valid for the Library Parts which are child elements of the “GS Door” subtype (e.g. “Door”, “Double Door”, “Metal Door”, etc.).

**Example 6**

Define the “Cost” Property for IfcDoor as Library Part independent parameter. For mapping, choose the “gs_list_cost” parameter of the “Double Door”. 

![Image of MAP IFC PROPERTIES FOR EXPORT dialog box]
To find this parameter, go to the Add Content drop-down button and choose Library Part parameters. From the appearing dialog box, first select the Double Door library part, then search for the gs_list_cost parameter as shown. However, make sure to add it as a Library Part Independent parameter:

**Example 7**

Define the “Cost” Property for IfcElement as Library Part independent parameter. For mapping, choose the “gs_list_cost” parameter of the “Double Door”. The mapping rule is valid for not just IfcDoor elements but all other Library Parts which will be converted to IFC Entities that are child element of IfcElement (e.g. IfcWindow, IfcFurnishingElement,
IfcDistributionElement, IfcTransportElement etc.) and contain the “gs_list_cost” parameter (e.g. “Armchair”, “Desk”, “Basin”, “Sink” etc.).
Data Conversion for IFC Export

File > Interoperability > IFC > IFC Translators

Choose a Translator for Export and open the Data Conversion preset.

Use this dialog to define which data, in addition to element geometry, should be exported to IFC. Such data can be useful in data exchange with facility management, energy analysis or cost estimation programs.

Select ARCHICAD Data to Export

Check the boxes of the ARCHICAD Data types you wish to export.

The required data varies depending the purpose of the resulting IFC file (and the software that will be used to open and/or edit it.)

- Classifications
  
  ARCHICAD Classifications are exported as IFC Classification Reference data.
- **Element Properties**
  Check to export ARCHICAD Properties as IFC Properties. (ARCHICAD Properties are defined in **Options > Property Manager**, and assigned to individual elements in their Settings dialog boxes or through the Interactive Schedule.)
  
  - Select this list item and use the popup to choose to export **All** properties, or **Visible properties only**.

  ![Image of Element Properties settings]

  **Note:** The Visible Properties option is only relevant if you have loaded an Add-On which controls property visibility in ARCHICAD. If no such add-on is loaded, then all properties are exported in every case.

- **Building Material Properties**
  
  - In IFC 2x3: Check to export ARCHICAD Building Material Properties (defined at Options > Element Attributes > Building Materials) as IFC Properties. Exported Building Material data is associated to the exported elements.
  
  - In IFC4: Exported Building Material data is associated to IFC Materials.

- **Element Parameters**
  Check to export ARCHICAD element parameters that convert to IFC Quantities or IFC Properties, depending on their type.

  **Note:** Choosing this option will significantly increase IFC file size. Export parameters only if you know that the target application can read these data.

  To filter the exported parameters by type: Select this list item and use the popup to choose to export **All** parameters, or **Quantity-type/Property-type data only**.

  ![Image of Element Parameters settings]

  - Quantity-type data include e.g. Weight, Length, Area, Volume, Time. Useful for data exchange with programs that can read quantities.
  
  - Property-type data include e.g. Library Part parameters.
- **Component Parameters**
  Export parameters of Composite Skins and Complex Profile components as IFC Properties or IFC Quantities, depending on their type.
  To filter the exported parameters by type: Select this list item and use the popup to choose to export **All** parameters, or **Quantity-type/Property-type data only**.
  - Quantity-type data include e.g. Weight, Length, Area, Volume, Time. Useful for data exchange with programs that can read quantities.
  - Property-type data include e.g. Library Part parameters.
  As a result, the exported Component data can be interpreted as such in IFC receiving applications, such as Solibri.

- **Door-Window Parameters**
  Export detailed information about ARCHICAD openings as IFC Door-Window Lining or Panel properties.

- **Zone Categories**
  Export the Zone Categories data (Code and Name) of ARCHICAD Zones as IFC Space Classification Reference data (ItemReference and Name).

**Export IFC Properties**
Choose an option for which IFC Properties and Classification References to export:
- **All IFC Properties** (all which are visible in the IFC Project Manager, no filter on)
- **Only Properties set in the Property Mapping Preset for the selected Translator**. (These properties are shown in the IFC Project Manager if you turn on the **Show Only Properties from Preview Translator** filter)

**Select Derived Data to Export**
Check one or more types of data to export to the IFC model.
- **IFC Base Quantities**

Check this to export Quantity Takeoff parameters (size, area and volume) to IFC. Useful in cost estimation applications.

The following table summarizes the base quantities by entity types automatically calculated and exported when using this option. The values of IfcSite's base quantities can be set manually at **Info > Project Info** (Site Gross Perimeter and Site Gross Area).

```
<table>
<thead>
<tr>
<th>IfcSite</th>
<th>Zone (IfcSpace)</th>
<th>IfcWall</th>
<th>IfcCurtainWall</th>
<th>IfcBeam</th>
</tr>
</thead>
<tbody>
<tr>
<td>GrossArea</td>
<td>Height</td>
<td>Length</td>
<td>Width</td>
<td>Length</td>
</tr>
<tr>
<td>GrossPerimeter</td>
<td>FinishCeilingHeight</td>
<td>Height</td>
<td>Length</td>
<td>Width (rectangle profile only)</td>
</tr>
<tr>
<td></td>
<td>FinishFloorHeight</td>
<td>Width</td>
<td>Height</td>
<td>Depth (rectangle profile only)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IfcBuilding</th>
<th>GrossFloorArea</th>
<th>GrossFootprintArea</th>
<th>GrossSideArea</th>
<th>CrossSectionArea</th>
</tr>
</thead>
<tbody>
<tr>
<td>GrossFloorArea</td>
<td>NetFloorArea</td>
<td>NetFootprintArea</td>
<td>NetSideArea</td>
<td>OuterSurfaceArea</td>
</tr>
<tr>
<td>GrossCeilingArea</td>
<td>GrossSideArea</td>
<td></td>
<td></td>
<td>GrossSurfaceArea</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Story (IfcBuildingStorey)</th>
<th>NetCeilingArea</th>
<th>NetSideArea</th>
<th>IfcDoor/IfcWindow/IfcOpening</th>
<th>TotalSurfaceArea</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>GrossWallArea</td>
<td>GrossVolume</td>
<td>Height</td>
<td>GrossVolume</td>
</tr>
<tr>
<td>NetHeight</td>
<td>NetWallArea</td>
<td>NetVolume</td>
<td>Width</td>
<td>NetVolume</td>
</tr>
<tr>
<td>GrossHeight</td>
<td>GrossPerimeter</td>
<td>Area</td>
<td>NetSurfaceArea ExrudedSide</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GrossFloorArea</th>
<th>NetPerimeter</th>
<th>IfcSlab</th>
<th>Depth</th>
<th>IfcColumn/IfcMember</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>GrossVolume</td>
<td>Width</td>
<td>Volume</td>
<td></td>
<td>IfcColumn/IfcMember</td>
<td>Length</td>
</tr>
<tr>
<td>NetVolume</td>
<td>Perimeter</td>
<td>Perimeter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpaceNetFloorAreaBOMA</td>
<td>GrossArea</td>
<td>GrossVolume</td>
<td>Width (rectangle profile only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpaceUsableFloorAreaBOMA</td>
<td>NetArea</td>
<td>GrossVolume</td>
<td>Depth (rectangle profile only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GrossVolume</td>
<td>NetVolume</td>
<td>GrossVolume</td>
<td>CrossSectionArea</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetVolume</td>
<td>GrossVolume</td>
<td>NetVolume</td>
<td>OuterSurfaceArea</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TotalSurfaceArea</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Export IFC Base Quantities**

- **IFC Space Containment**: Export data defining the relationship between ARCHICAD Zones and objects they contain. This feature is useful in facility management applications.
• Space Containment is relevant only for elements, within an ARCHICAD Zone, which were created using the Object, Lamp, Morph or Slab tools.
  - For Object, Lamp or Morph elements: These elements are in space containment only if their home story is the same as that of the Zone, and if the center of the elements’ bounding box falls within the Zone's 2D polygon.
  - A Slab is in space containment if its reference line falls within the Zone top/bottom, and if the Slab polygon falls within the Zone polygon.
• Click **Filter Containment** to limit the contents of the Space Containment by their IFC Element Type.

  - **IFC Space Boundaries:** Export geometry data of ARCHICAD Zones. (Useful in thermal calculation applications.)

  ARCHICAD Zones include precise geometry data that are useful to thermal calculation software applications. Zones are 3D solids in geometrical aspect and in normal cases are bordered by two slabs and four walls. Space boundaries define the logical connection between ARCHICAD Zones (IfcSpace) and the building elements that enclose them. In practice, Walls, Slabs, Roofs, Windows, Doors etc. all have different thermal conductivity properties. If you activate the “IFC Space boundaries” option, ARCHICAD will export Space boundaries and their relations (IfcRelSpaceBoundary) together with the Zones (IfcSpace) to the IFC file. In other words, ARCHICAD will calculate the position, size and adjacency of the elements that border each Zone. ARCHICAD divides the Zone boundaries according to the areas defined and cut by connected elements and openings.

  ![Space Boundaries](image)

  **Space Boundaries (defined by Walls):**
  1. Wall part defined by Zone3
  2. Wall part defined by Zone2
  3. Wall part cut by connected wall
  4 and 5. Area defined by door opening

  **Space Boundaries (defined by Slab):**
  1. Slab part defined by Zone1
  2. Slab part defined by Zone3
  3. Slab part defined by Zone2
  4. Slab part without thermal connection
IFC Global Unique Identifier Attribute (GlobalId)

- Keep ARCHICAD IFC ID: IFC GlobalId Attributes of elements (assigned automatically by ARCHICAD) will be retained in the exported IFC model.
  - The “Keep ARCHICAD IFC ID” option is useful when using other programs to compare two IFC model versions arriving from ARCHICAD.
  - This option is recommended when comparing two IFC models in ARCHICAD: see Detect IFC Model Changes.
  - This option is recommended for the BCF workflow, in which the roundtrip data exchange identifies model elements using their GlobalId Attributes.

- Generate new values: Each new exported IFC file will generate brand new GlobalIds for the elements, so that each new exported version is entirely separate from the previous versions.
  
  Note: This option has no effect on the Merge to IFC Model export process.

See also How to Control Global ID (IFC Attribute) Based on ARCHICAD Project Info.
Unit Conversion for IFC Export

File > Interoperability > IFC > IFC Translators
Choose a Translator for Export and open the Unit Conversion preset.
Set unit types globally for the export of all coordinates, geometric parameters and "Measure"-type IFC Properties.
Filter Model at Import (Secondary Filter)

When Hotlinking, Merging or Opening an IFC file, you must select an IFC Translator for Import, which controls the conversion process. Every IFC Translator for Import has a filtering component (see Model Filter for IFC Import), which defines which elements of the IFC model should be placed in ARCHICAD (and which should be skipped).

Each Translator for Import also contains another, secondary Model Filter function. This dialog (Model Filter for Import) allows you to further fine-tune the set of imported IFC elements, based on more specific element categories - e.g. type, story, owner.

However, this secondary Model Filter for Import dialog does not appear by default. To use this feature, turn it on in IFC Translator Settings:

1. Go to File > Interoperability > IFC > IFC Translators.
2. Select a Translator for Import.
3. Under Settings, open Model Filter Settings.
4. Check the **Show Model Filter dialog box on import** box.

Now the **Model Filter for Import** dialog will appear when you open, hotlink or merge an IFC file to ARCHICAD. Use it to apply custom element filters to the current import process.
To make filtering easier, sort the list items or grouping them as follows:

- **IFC Element Type**
- **Story**: List elements by their story location
- **Layer**: List IFC element types and elements by layer
- **Element Owner**: List element types and elements according to who created them in IFC

**Note on Element Owner**
- Elements in IFC models always have an owner attached. If the IFC file is exchanged among many users and programs, an element may have multiple owners.
- The IFCProject entity, like all IFC entities, also has an owner. When an IFC project is imported to ARCHICAD, the IFCProject entity’s owner are added to ARCHICAD’s Project Info. At export from ARCHICAD, the model elements are all assigned to this owner.

**Additional Element Filtering**
If needed, filter elements further by IFC Domain or by Structural Function.
Filter Model at Export

Each IFC Translator contains settings for filtering the elements to be exported. However, you can further fine-tune the set of exported elements during the export process.

IFC Save Options: Elements to Export

1. Go to File > Save as.
2. Choose an IFC file format.
3. In the Export field, choose an option:
   • Selected elements only in the current view (this option is only available if the current view includes some selected elements)
   • Visible elements on all stories. When saving from Floor Plan view, you can choose to export visible elements on just the current story. Visibility depends on display settings (Layers, Partial Structure display, etc.).
   • Entire project, regardless of any selection or layer settings.

Notes:
   • In order to export 2D drawing-type elements, annotation element or Grid elements, it is not enough to meet the criteria of the filters listed above (e.g. export based on selected or visible elements); you must also specifically enable their export, using the translator settings. (See Select 2D Elements to Export.)
   • Publisher always uses the ‘visible’ element export mode, independently of the Model Filter settings of the applied IFC Translator for Export.
IFC Save Options: Model Filter

From the Save dialog, click the Filter button to open this dialog box.

Use this list to further filter the elements to be exported.

**Group element list by**

To make filtering easier, sort the list items or grouping them as follows:

- **IFC Element Type**
- **Story**: List elements by their story location
- **Layer**: List IFC element types and elements are listed by layer.
- **Element Owner**: element types and elements are listed according to who created them. (At export, all elements are considered as belonging to the same owner.)

*See also Note on Element Owner.*

**Additional Element Filtering**

If needed, filter elements further by IFC Domain or by Structural Function.
Appendix: IFC Terms and Concepts

The following sections provide additional detail about terms and concepts used in IFC.

**Model View Definitions**

**IFC Data Types**

**Model View Definitions**

A *Model View Definition*, MVD (or IFC View Definition) is a recommendation for which data and elements the IFC model should include, depending on the purpose of the model exchange.

Model View Definitions are either defined within buildingSMART International, or by other organizations and interest groups.

ARCHICAD IFC Export and Import supports the following Model View Definitions (choose an MVD in the Translator for Export Settings):

**IFC2x3 Schema**

- The *Coordination View* is currently the most widely implemented view of the IFC Schema. Its main purpose is to allow sharing of building information models among the disciplines of architecture, structural engineering, and building service. It contains definitions of spatial structure, building, and building service elements. ARCHICAD is certified for both import and export of the latest version: IFC2x3 Coordination View 2.0.

- The IFC2x3 *Coordination View (Surface Geometry)* is a simplified publishing format (i.e. a subset) of the Coordination View. This format is suitable for viewing (since all IFC viewers support this format), design coordination, clash prevention during design, and clash checking, similarly to IFC4 Reference View. “Coordination View (Surface...
Geometry)” means that every element will be exported with its BREP (boundary representation) geometry. This method comes closest to reproducing the real shape of the element, together with its specialized sections, connections and solid operations. (However, the element’s parameters are lost, and BREP elements from an imported IFC file are transformed into non-editable elements.)

– The IFC2x3 **Basic FM Handover View** is an extended version of the Coordination View (developed by buildingSMART) that defines the general requirements for design applications to enable the handover of facility management information. The basic scope can be summarized as the space and equipment list for the spatial and technical systems of a facility. Technically, the Basic FM Handover View fulfills the following requirements above and beyond those of the abovementioned Coordination View: ability to assign furnishing and equipment components to spaces (Space Containment, IFC System), to assign spaces to zones (IFC Zone), to assign a classification to spaces and components (Classification Reference), to assign manufacturer base properties to components (standard and custom IFC Properties), to assign doors and windows to spaces (Space Boundaries), to assign type information for components (IFC Type Product) and to export base quantities for all project components and spatial structures. This MVD is required in various projects defined by buildingSMART and other organizations. An example is the COBie (Construction-Operations Building information exchange), a specification used in the handover of Facility Management information. It is a spreadsheet data format for the delivery of a subset of building model information, rather than geometric model information. ARCHICAD’s BIM-quality models and IFC data exchange capabilities produces data output that is easily converted into COBie documentation, with the help of free or commercial conversion programs.

– There are several other Model View Definitions (generally the extended versions of the Coordination view) specified by organizations or development teams outside of buildingSMART International.
The IFC4 Schema further divides the Coordination View into two Model View Definitions:

**Note:** The IFC4 Schema is not supported by all applications. Use an MVD of the IFC4 Schema only if you are certain that it is supported by the application that will receive IFC data.

- **IFC4 Reference View:** Suitable for all BIM workflows based on reference models, where the exchange is mainly one-directional. Requested modifications of the BIM data, mainly of the shape representation, are handled by a change request to the original author.
  - When exporting to IFC4:
    - the relation connections of chained Walls and Beams are omitted
    - Surfaces of Building Materials are omitted

- **IFC4 Design Transfer View:** Provides building information with support for editing of interconnected elements: inserting, deleting, moving, and modifying physical building elements and spaces, within the limited scope of parametric exchange. An example of a target scenario is an architect providing building design information to an engineer for a particular discipline, where geometric modifications may be needed. Note that the Design Transfer View is not meant for round-trip model exchange scenarios.

All Model View Definitions can be extended by definitions which support additional exchange requirements:

- the Quantity Take-off add-on view adds the ability to transmit base quantities for all spatial and building elements
- the Space Boundary add-on view adds building elements to space relationships to support models in thermal and energy analysis
- the 2D Annotation add-on view supports the exchange of additional 2D element representations and annotations of building models
IFC Data Types

This chapter summarizes the main IFC data types available in ARCHICAD.

IFC Entity
IFC Model Hierarchy
IFC Type
IFC Type Product
IFC Container
IFC Attributes
IFC Properties
IFC Classification Reference
IFC Assignments

IFC Entity

In an IFC model, the project information (generated, for example, from an ARCHICAD project) is represented as a set of IFC Entities - such as IFC Type, Attribute, Assignment, Type Product. Each IFC Entity (for example, an IfcWall) includes a fixed number of IFC Attributes, plus any number of additional IFC Properties.

Some IFC Entities express characteristics of other entities. Some of these correspond to ARCHICAD attributes. These correspondences are mapped automatically when the IFC model is generated or exported, or when the IFC model is imported.

<table>
<thead>
<tr>
<th>ARCHICAD Attribute</th>
<th>IFC Entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer</td>
<td>IfcPresentationLayerAssignment</td>
</tr>
<tr>
<td>Building Material</td>
<td>IfcMaterial</td>
</tr>
<tr>
<td>Surface</td>
<td>IfcSurfaceStyleRendering</td>
</tr>
<tr>
<td>Composite</td>
<td>IfcMaterialLayerSet (extruded geometry) or IfcMaterialList (BREP geometry)</td>
</tr>
<tr>
<td>Profile</td>
<td>IfcProfileDef</td>
</tr>
</tbody>
</table>

You can set different preferences for converting Layers, Building Materials and Surfaces of imported IFC models: use the conversion settings of Import translators.

See Layer Conversion for IFC Import and Material and Surface Conversion.
IFC Model Hierarchy

An IFC model is composed of IFC Entities built up in a hierarchical order. As shown in the following illustration, each story level (IfcBuildingStorey) has its corresponding story in ARCHICAD.

In ARCHICAD, all elements and objects are linked to a home story. Thus, by default, the IFC model hierarchy lists them under the IfcBuildingStorey of the same name as the elements’ home story. However, in IFC Project Manager, elements can be assigned directly to the IfcSite or IfcBuilding. So, for example, neighboring buildings (e.g. defined by the Morph tool) and site context elements (trees, fences, roads, etc.) can be assigned to the site instead of the project building with its story system.

By default, the IFC elements (for example the IfcBuildingElements) and the IfcSpace entities are on the same hierarchy level in an IFC model. However, ARCHICAD Objects and Morphys - regardless of their Classification - can be displayed on and, for IFC export purposes, linked to the ARCHICAD Zone (IfcSpace) that contains them, instead of to their home story.

IFC Spatial Elements

IFC Spatial Elements are IfcProject, IfcSite, IfcBuilding, IfcBuildingStorey, as well as IfcSpace. They are at the top of the IFC Project Manager Hierarchy.

These elements can only be managed through the IFC Project Manager, where you can also edit their IFC-related data.

The IFC Attribute values of these spatial elements, however, are derived from the data of the current ARCHICAD project.

IfcSite is the geographic position of the IfcProject. It can have a geometry, but a geometry is not required. In ARCHICAD, site geometry is represented by Mesh elements, Site-type Objects, or elements with “Site Geometry” Classification.
ARCHICAD can handle and import one building (IfcBuilding) only. But it can import more than one IfcSite, even though the IfcSite is above the IfcBuilding in the hierarchy. Thus, when importing an IFC file that contains multiple buildings, you can choose only one to import.

See Building and Site Selection.

However, other applications can export a building’s topography into multiple IfcSites. In this case, importing the IfcBuilding will import all of the IfcSites, merged into the one IfcSite that actually contains the imported IfcBuilding. As a result, you will end up with a single IfcSite and a single IfcBuilding, but the IfcSite includes all of the IfcSites.

Note: By default, ARCHICAD assigns identical GlobalID attributes to the following entities: IFC Project, IFC Site, IFC Building, and IFC Story. More precisely, the Global IDs will be identical provided that the respective ID fields, defined at ARCHICAD’s Project Info dialog box (File > Info) contain identical keywords (or no value at all). However, you can alter these keywords in the Project Info dialog box to control whether the spatial entities have identical or different GlobalIDs.

How to Control Global ID (IFC Attribute) Based on ARCHICAD Project Info

By default, ARCHICAD assigns identical GlobalID attributes to the following entities: IFC Project, IFC Site, IFC Building, and IFC Story. More precisely: the Global IDs will be identical, provided that the respective ID fields, defined at ARCHICAD’s Project Info dialog box (File > Info) contain identical keywords (or no value at all). However, you can alter these keywords in the Project Info dialog box to control whether the spatial entities have identical or different GlobalIDs.

Suppose you have two separate buildings (stored in two different ARCHICAD projects). You want both projects and both sites to share the same GlobalID; yet you want the various buildings on each site to have different GlobalIDs.

To achieve this, enter the same keyword in the “Project ID” and “Site ID” fields of both projects. Enter different keywords for the “Building ID” fields.
IFC Story entities have no corresponding ID field in the Project Info dialog box. The GlobalIDs of IFC Story entities are derived from their Building ID. If two buildings in two different ARCHICAD projects have the same Building ID, then all stories of those buildings which have the same Story Number will have the same Global ID.

**IFC Type**

IFC Type is one kind of IFC entity - it groups IFC model elements into a hierarchical structure, represented by the tree structure in the IFC Project Manager.

When a model is exported to IFC format, every one of its elements is assigned an IFC Type. In ARCHICAD, IFC Types are generated based on the Type Mapping definition (either by Tool or by Classification) in the Translator for Export.

*See Type Mapping for IFC Export.*

in ARCHICAD, view any element’s IFC Type in the Manage IFC Properties window of Element Settings (or for any selected element in IFC Project Manager).
You can also use Find & Select to filter the project by “IFC Type” criteria, or use Interactive Element Schedule to list this data for ARCHICAD elements. For example, you can select or list just the model elements having IfcSlab IFC Type.

See Define Element Criteria using IFC Data.

**IFC Type Product**

An IFC Type Product defines a particular style/type of other entities by relating to them with common IFC Attributes and Properties. For example, IfcWindowStyle is an IFC Type Product, to which many windows (IfcWindow) refer.

IFC Type Product entities are generated for ARCHICAD elements based on the Type Mapping definition in the Translator for Export.

See Type Mapping for IFC Export.

**IFC Container**

IFC Container (relating object of IfcRelAggregates) is an IFC entity that does not have its own body geometry, but its components (related objects of IfcRelAggregates) contain all geometry and structure-related data.

**Exporting Hierarchical Elements from ARCHICAD as IFC Containers**

In an ARCHICAD project, the IFC Translator for Export gives you the option of exporting hierarchical elements (Curtain Wall, Stair, Railing) to IFC as either a single element, or as a hierarchical one.
- If exported with the hierarchical method (“Keep Hierarchy”), it will be an **IFC Container** entity, and its sub-elements will be individual IFC elements. This reflects the multi-part hierarchy of the original ARCHICAD element (e.g. Stair).
- If exported as a single element, it will be a **single IFC entity**, which contains within itself the geometry of all its sub-elements. The hierarchical nature of the original element (e.g. Stair, with all its separate sub-components) is thus lost.
- IFC export that uses the “Explode Composite and Complex Profile elements into parts” option generates **IFC Container** elements from building elements in the output IFC file: for example a composite wall element is saved as an “IfcWall”-type IFC Container element without geometry, and its skin parts will provide the geometry as “IfcBuildingElementPart” elements.

*These export options are found at [Geometry Conversion for IFC Export](#).*

**IFC Attributes**

IFC Attributes are the main identifiers of IFC Entities. The names of IFC Attributes are fixed, having been defined by buildingSMART as part of the IFC standard code.

Most of these IFC Attribute names are derived from the project. For example, the IFC Attributes of an IfcWall building element:
- GlobalId: the Globally Unique Identifier of the IfcWall in the IFC model (not editable).
- OwnerHistory: the assignment of the information about the current ownership of the IfcWall.
- Name: its factory-default derived value is IfcWall’s ARCHICAD ID (Wall Settings dialog box > Classification and Properties panel).
- Description: an optional textual description.
- ObjectType: an optional text to define a subtype of an element or add type information to it.
- Tag: its factory-default derived value is the IfcWall’s ARCHICAD “Unique ID” (not the same as IFC GlobalId).
OwnerHistory is directly attached to all independent objects, relationships and properties. Its components and values are derived from project data and hidden in the ARCHICAD user interface. It includes, for example, the owning actor (OwningUser) (certain owner data is added to ARCHICAD’s Project Info (File > Info).

**IFC Properties**

IFC Properties are additional (mostly IFC Type-specific) parameters assigned to an IFC Entity. IFC Properties can be standard or non-standard.

- Standard, so-called “IFC2x3 Schema” data are defined by buildingSMART and stored in property sets whose names begin with the prefix “Pset_”
- Non-standard data are created by the exporting application using any property name and stored in any property set (the names of these property sets usually contain the name of the exporting application, or the IFC Model View Definition which requires the property.

See [Property Mapping for IFC Export](#).

**IFC Classification Reference**

A Classification Reference (IfcClassificationReference) arranges IFC elements into a category. You can assign an Item Reference identifier, a classification Name attribute and some other optional parameters to all project elements (such as the building, the stories, the building elements, or the zones).
You can classify elements with this system both in IFC Project Manager and the element Settings dialog. 

See Create New, Custom IFC Property

**IFC Assignments**

IFC Assignments (IfcRelAssigns) define the relationship among project elements. Each assignment type can have its own IFC Attribute (the most significant is the Object Type), and standard and custom IFC Properties. The major assignment types of the IFC standard are the following:

- **IFC Group** (IfcGroup): Use this to group any project elements (building element, story etc.) together. For example: the column and beam components of a frame standing are grouped together. Grouping by multilevel-hierarchy is also available: for example, you can group the frame standing groups in a ‘frame-system’ group.

- **IFC Zone** (IfcZone): Use this to group IfcSpace elements (the equivalent of ARCHICAD Zones) together. For example: ARCHICAD Zones having the identical function are grouped into an IfcZone named e.g. “Security Zone.” Grouping by multilevel-hierarchy is also available for IfcZone assignments. For example, you can group some ARCHICAD Zones (IfcSpaces) in an IfcZone (Security Zones) that is a part of a higher level IfcZone group (Governmental Zones).

- **IFC System** (IfcSystem): Use this to group any project elements (especially MEP elements) in a system hierarchy manually, by using MEP Modeler defined systems, or by importing systems exported from e.g. MEP applications. Definition of sub-system hierarchy (parent and child system) is also available. For example: group elevators in a vertical circulation system which can be a child system of a mechanical system. Or, assign plumbing elements to the cold water sub-system of a plumbing system. You can also tie systems to a spacial structure relation (IfcSite, IfcBuilding, IfcStorey or IfcSpace). For example, add to a duct system all the ARCHICAD Zones (IfcSpace) that it runs through.

- **IFC Building Systems**

- **IFC Distribution Systems**

ARCHICAD supports all of the above mentioned IFC Assignment types:

- the IFC Project Manager interface lets you define any assignments in your project and manage all their IFC data;

- all of the above mentioned assignment data are created at IFC model import (for example IfcSystems stored in an MEP-type IFC model, IfcZones defined in an FM application);

- all available IFC Assignments (defined manually or previously imported) are exported with a new IFC model mapped from the current ARCHICAD project.

See Using Assignments in IFC Project Manager.
Appendix: IFC Data Mapping in ARCHICAD

This section contains two charts with detailed mapping information that is built in to ARCHICAD.

Predefined Property Mapping (Export ARCHICAD to IFC)
Built-in IFC Type Mapping for ARCHICAD

Related Topic:
Data Types for Properties in IFC and ARCHICAD

Predefined Property Mapping (Export ARCHICAD to IFC)

The Property Mapping preset of the IFC Translator for Export defines the assignment of IFC Properties and Attributes when exporting ARCHICAD model to IFC.

See Property Mapping for IFC Export.

Some Attribute and Property data come with a predefined mapping rule, which you do not have to create yourself in Property Mapping.

Although these rules do not appear in the Map IFC Properties for Export dialog box, they can be seen (if they have values) with a gray chain icon in the IFC Project Manager and Element Settings.

These rules are listed in the following table.
<table>
<thead>
<tr>
<th>ARCHICAD Command</th>
<th>ARCHICAD Parameter</th>
<th>IFC Entity Types</th>
<th>IFC Data</th>
<th>IFC Project Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Info</td>
<td>Project Name</td>
<td>IfcProject</td>
<td>Attribute&gt;\textnormal{Name}</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Project Description</td>
<td>IfcProject</td>
<td>Attribute&gt;\textnormal{Description}</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Project ID</td>
<td>IfcProject</td>
<td>Attribute&gt;GlobalId (control, see Note later)</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Project Status</td>
<td>IfcProject</td>
<td>Attribute&gt;Phase</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Location</td>
<td>Project North</td>
<td>IfcProject</td>
<td>Attribute&gt;\textnormal{Representati-\textnormal{onContext}}\textnormal{&gt;TrueNorth}</td>
<td>-</td>
</tr>
<tr>
<td>Project Location</td>
<td>Latitude</td>
<td>IfcSite</td>
<td>Attribute&gt;RefLatitude</td>
<td>visible</td>
</tr>
<tr>
<td>Project Location</td>
<td>Longitude</td>
<td>IfcSite</td>
<td>Attribute&gt;RefLongitude</td>
<td>visible</td>
</tr>
<tr>
<td>Project Location</td>
<td>Altitude</td>
<td>IfcSite</td>
<td>Attribute&gt;RefAltitude</td>
<td>visible</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Name</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{Name}</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site ID</td>
<td>IfcSite</td>
<td>Attribute&gt;Global Id (control, see Note later)</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Description</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{Description}</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;\textnormal{Site Address1}</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{SiteAddress}&gt;AddressLines</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;\textnormal{Site Address2}</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{SiteAddress}&gt;PostalBox</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;\textnormal{Site Address3}</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{SiteAddress}&gt;Town</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;\textnormal{Site Postal Box}</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{SiteAddress}&gt;PostalBox</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;\textnormal{Site City}</td>
<td>IfcSite</td>
<td>Attribute&gt;\textnormal{SiteAddress}&gt;Town</td>
<td>-</td>
</tr>
<tr>
<td>ARCHICAD Command</td>
<td>ARCHICAD Parameter</td>
<td>IFC Entity Types</td>
<td>IFC Data</td>
<td>IFC Project Manager</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>------------------</td>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;Site State</td>
<td>IfcSite</td>
<td>Attribute&gt;SiteAddress&gt;Region</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;Site Postcode</td>
<td>IfcSite</td>
<td>Attribute&gt;SiteAddress&gt;PostalCode</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Full Address&gt;Site Country</td>
<td>IfcSite</td>
<td>Attribute&gt;SiteAddress&gt;Country</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Gross Perimeter</td>
<td>IfcSite</td>
<td>BaseQuantity&gt;GrossPerimeter</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Site Gross Area</td>
<td>IfcSite</td>
<td>BaseQuantity&gt;GrossLandArea</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Building Name</td>
<td>IfcBuilding</td>
<td>Attribute&gt;Name</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Building Description</td>
<td>IfcBuilding</td>
<td>Attribute&gt;Description</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Project Info</td>
<td>Building ID</td>
<td>IfcBuilding &amp; IfcBuildingStor (control, see Note later)</td>
<td>Attribute&gt;GlobalId</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Name&gt;Prefix Title</td>
<td>IfcPerson</td>
<td>Attribute&gt;PrefixTitles</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Name&gt;Given Name</td>
<td>IfcPerson</td>
<td>Attribute&gt;GivenName</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Name&gt;Middle Name</td>
<td>IfcPerson</td>
<td>Attribute&gt;MiddleNames</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Name&gt;Family Name</td>
<td>IfcPerson</td>
<td>Attribute&gt;FamilyName</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Name&gt;Suffix Title</td>
<td>IfcPerson</td>
<td>Attribute&gt;SuffixTitles</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact ID</td>
<td>IfcPerson</td>
<td>Attribute&gt;Id</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Role</td>
<td>IfcPerson</td>
<td>Attribute&gt;Roles</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Department</td>
<td>IfcPerson</td>
<td>Addresses&gt;Postal&gt;InternalLocation</td>
<td>-</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Company</td>
<td>IfcOrganization</td>
<td>Attribute&gt;Name</td>
<td>-</td>
</tr>
<tr>
<td>ARCHICAD Command</td>
<td>ARCHICAD Parameter</td>
<td>IFC Entity Types</td>
<td>IFC Data</td>
<td>IFC Project Manager</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>------------------</td>
<td>---------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Company Code</td>
<td>IfcOrganization Attribute&gt;Id</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Address1</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Postal AddressLines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Address2</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Postal Box</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Address3</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Town</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Postal Box</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Region</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Postcode</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Postal Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Full Address&gt; Contact Country</td>
<td>IfcPerson &amp;IfcOrganization Attribute&gt;Addresses&gt;Country</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact E-mail</td>
<td>IfcPerson &amp;IfcOrganization lecom&gt;ElectronicMailAddress</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Phone Number</td>
<td>IfcPerson &amp;IfcOrganization lecom&gt;TelephoneNumbers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Fax</td>
<td>IfcPerson &amp;IfcOrganization lecom&gt;FacsimileNumbers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Info</td>
<td>Contact Web</td>
<td>IfcPerson &amp;IfcOrganization lecom&gt;WWWHomePageURL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Story Settings</td>
<td>Elevation</td>
<td>IfcBuildingStorey Attribute&gt;Elevation</td>
<td></td>
<td>visible/editable</td>
</tr>
<tr>
<td>Zone Settings</td>
<td>Name</td>
<td>IfcSpace Attribute&gt;LongName</td>
<td></td>
<td>visible/editable</td>
</tr>
<tr>
<td>ARCHICAD Command</td>
<td>ARCHICAD Parameter</td>
<td>IFC Entity Types</td>
<td>IFC Data</td>
<td>IFC Project Manager</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>------------------</td>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Zone Settings</td>
<td>Number (No)</td>
<td>IfcSpace</td>
<td>Attribute&gt;name</td>
<td>visible/editable</td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>Attribute&gt;name</td>
<td>visible/editable</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;ID</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>Attribute&gt;Objecttype</td>
<td>visible (editable in Export Translator, Type Mapping)</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>Attribute&gt;PredefinedType</td>
<td>visible (editable in Export Translator, Type Mapping)</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>Pset...Common&gt;LoadBearing</td>
<td>visible</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;Structural Function</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>Pset...Common&gt;IsExternal</td>
<td>visible</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;Position</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC element</td>
<td>AC_Pset_RenovationAndPhasing&gt;RenovationStatus</td>
<td>visible</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;Renovation Status</td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC type</td>
<td>Attribute&gt;ElementType</td>
<td>visible (editable in Export Translator, Type Mapping)</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;</td>
<td>product)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(element)&gt;</td>
<td>Classification and</td>
<td>(IFC type</td>
<td>Attribute&gt;PredefinedType</td>
<td>visible (editable in Export Translator, Type Mapping)</td>
</tr>
<tr>
<td>Settings</td>
<td>Properties&gt;</td>
<td>product)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule&gt;</td>
<td>General&gt;Unique ID</td>
<td>(IFC element</td>
<td>Attribute&gt;Tag</td>
<td>visible/editable</td>
</tr>
<tr>
<td>(element)</td>
<td></td>
<td>type)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window/Door</td>
<td>Preview and</td>
<td>IfcWindow /</td>
<td>Attribute&gt;OverallWidth</td>
<td>visible</td>
</tr>
<tr>
<td>Settings</td>
<td>Positioning&gt;Width</td>
<td>IfcDoor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ARCHICAD Command</td>
<td>ARCHICAD Parameter</td>
<td>IFC Entity Types</td>
<td>IFC Data</td>
<td>IFC Project Manager</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>------------------</td>
<td>---------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Window/Door Settings (automatic type naming rule)</td>
<td>Preview and Positioning&gt;Height</td>
<td>IfcWindow / IfcDoor</td>
<td>Attribute&gt;OverallHeight</td>
<td>visible</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IfcColumn</td>
<td>Pset_ColumnCommon&gt;Reference</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IfcColumnType</td>
<td>Attribute&gt;Name</td>
<td>visible/editable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IfcBeam</td>
<td>Pset_BeamCommon&gt;Reference</td>
<td>visible/editable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IfcBeamType</td>
<td>Attribute&gt;Name</td>
<td>visible/editable</td>
</tr>
</tbody>
</table>
Built-in IFC Type Mapping for ARCHICAD

When an ARCHICAD model is exported to IFC, each element is assigned an IFC Element Type.

Type Mapping is defined in the IFC Translator for Export, in the Type Mapping preset: either by Element Type or by Classification.

See Type Mapping for IFC Export.

The following 3 charts show the Type Mapping that results using the automatic, “by Element Type” method.

ARCHICAD Tool
LibPart (By UnId)
MEP (By Tool)
## ARCHICAD Tool

<table>
<thead>
<tr>
<th>ARCHICAD Tool</th>
<th>IFCObjectType</th>
<th>IFCObject PredefinedType</th>
<th>IFCTypeObject PredefinedType</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IFCBeam</td>
<td>IFCBeamType</td>
<td></td>
</tr>
<tr>
<td>Column</td>
<td>IFCColumn</td>
<td>IFCColumnType</td>
<td></td>
</tr>
<tr>
<td>Wall</td>
<td>IFCWall</td>
<td>IFCWallType</td>
<td></td>
</tr>
<tr>
<td>Shell</td>
<td>IFCSlab</td>
<td>ROOF</td>
<td>IFCSlabType</td>
</tr>
<tr>
<td>Roof</td>
<td>IFCSlab</td>
<td>ROOF</td>
<td>IFCSlabType</td>
</tr>
<tr>
<td>Slab</td>
<td>IFCSlab</td>
<td>FLOOR</td>
<td>IFCSlabType</td>
</tr>
<tr>
<td>Mesh</td>
<td>IFCSite</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Morph</td>
<td>IFCBuildingElementProxy</td>
<td>IFCTeleportType</td>
<td>IFCTeleportType</td>
</tr>
<tr>
<td>Railing</td>
<td>IFCRailing</td>
<td>IFCRailingType</td>
<td></td>
</tr>
<tr>
<td>Baluster</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Handrail</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Inner Post</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Railing Panel</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Railing Post</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Rail</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Toprail</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Handrail Connection</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Rail Connection</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Toprail Connection</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Handrail End</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Rail End</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Toprail End</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Railing Node</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Railing Segment</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Railing Pattern</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Stair</td>
<td>IFCStair</td>
<td>IFCStairType</td>
<td></td>
</tr>
<tr>
<td>Riser</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>ARCHICAD Tool</td>
<td>IFCObjectType</td>
<td>IFCObject</td>
<td>IFCObject PredefinedType</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>-----------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Stair Structure</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Tread</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall</td>
<td>IFCCurtainWall</td>
<td>IFCCurtainWallType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall Frame</td>
<td>IFCMember</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall Panel</td>
<td>IFCPlate</td>
<td>IFCPlateType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall Accessory</td>
<td>IFCDiscreteAccessory</td>
<td>IFCDiscreteAccessoryType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall Segment</td>
<td>IFCDiscreteAccessory</td>
<td>IFCDiscreteAccessoryType</td>
<td></td>
</tr>
<tr>
<td>Curtain Wall Junction</td>
<td>IFCDiscreteAccessory</td>
<td>IFCDiscreteAccessoryType</td>
<td></td>
</tr>
<tr>
<td>Zone</td>
<td>IFCSpace</td>
<td>IFCSpaceType</td>
<td></td>
</tr>
<tr>
<td>Door</td>
<td>IFCDoor</td>
<td>IFCDoorType</td>
<td></td>
</tr>
<tr>
<td>Skylight</td>
<td>IFCWindow</td>
<td>IFCWindowType</td>
<td></td>
</tr>
<tr>
<td>Window</td>
<td>IFCWindow</td>
<td>IFCWindowType</td>
<td></td>
</tr>
<tr>
<td>Opening</td>
<td>IFCOpeningElement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td>IFCFurniture</td>
<td>IFCFurnitureType</td>
<td></td>
</tr>
<tr>
<td>Lamp</td>
<td>IFCLightFixture</td>
<td>IFCLightFixtureType</td>
<td></td>
</tr>
<tr>
<td>Fill</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Spline</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Polyline</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Circle</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Dimension</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Angle Dimension</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Level Dimension</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Radial Dimension</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>ARCHICAD Tool</td>
<td>IFCObjectType</td>
<td>IFCObject</td>
<td>IFCObject PredefinedType</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Text</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>IFCAnnotation</td>
<td>Undefined</td>
<td></td>
</tr>
<tr>
<td>LibPart (By UnId)</td>
<td>Archicad</td>
<td>IFCObjectType</td>
<td>IFCTypeObjectTypeName</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>---------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>curtainWallFrame</td>
<td>IFCBuildingElementProxy</td>
<td>IFCBuildingElementProxyType</td>
<td></td>
</tr>
<tr>
<td>curtainWallPanel</td>
<td>IFCBuildingElementProxy</td>
<td>IFCBuildingElementProxyType</td>
<td></td>
</tr>
<tr>
<td>stair</td>
<td>IFCStair</td>
<td>IFCSpatialStructuralElementType</td>
<td></td>
</tr>
<tr>
<td>opening</td>
<td>IFCOpeningElement</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>wallOpening</td>
<td>IFCOpeningElement</td>
<td>IFCMemberType</td>
<td></td>
</tr>
<tr>
<td>wallDoor</td>
<td>IFCDoor</td>
<td>IFCDoorStyle</td>
<td></td>
</tr>
<tr>
<td>wallWindow</td>
<td>IFCWindow</td>
<td>IFCRampFlightType</td>
<td></td>
</tr>
<tr>
<td>roofOpening</td>
<td>IFCWindow</td>
<td>IFCRampFlightType</td>
<td></td>
</tr>
<tr>
<td>beam</td>
<td>IFCBeam</td>
<td>IFCBeamType</td>
<td></td>
</tr>
<tr>
<td>column</td>
<td>IFCColumn</td>
<td>IFCColumnType</td>
<td></td>
</tr>
<tr>
<td>covering</td>
<td>IFCCovering</td>
<td>IFCCoveringType</td>
<td></td>
</tr>
<tr>
<td>light</td>
<td>IFCFlowTerminal</td>
<td>IFCFlowTerminalType</td>
<td></td>
</tr>
<tr>
<td>curtainWall</td>
<td>IFCCurtainWall</td>
<td>IFCCurtainWallType</td>
<td></td>
</tr>
<tr>
<td>discreteAccessory</td>
<td>IFCDiscreteAccessory</td>
<td>IFCDiscreteAccessoryType</td>
<td></td>
</tr>
<tr>
<td>footing</td>
<td>IFCFooting</td>
<td>IFCFlowTreatmentDeviceType</td>
<td></td>
</tr>
<tr>
<td>furnishing</td>
<td>IFCFurnishingElement</td>
<td>IFCFurnishingElementType</td>
<td></td>
</tr>
<tr>
<td>railing</td>
<td>IFCRailing</td>
<td>IFCRailingType</td>
<td></td>
</tr>
<tr>
<td>ramp</td>
<td>IFCRamp</td>
<td>IFCRailingType</td>
<td></td>
</tr>
<tr>
<td>roof</td>
<td>IFCRoof</td>
<td>IFRampFlightType</td>
<td></td>
</tr>
<tr>
<td>slab</td>
<td>IFCSlab</td>
<td>IFCSlabType</td>
<td></td>
</tr>
<tr>
<td>wall</td>
<td>IFCWall</td>
<td>IFCRampFlightType</td>
<td></td>
</tr>
<tr>
<td>wallEnd</td>
<td>IFCCovering</td>
<td>IFCCoveringType</td>
<td></td>
</tr>
<tr>
<td>gridElementMarker</td>
<td>IFCGridAxis</td>
<td>IFCFurnishingElementType</td>
<td></td>
</tr>
<tr>
<td>slabOpening</td>
<td>Undefined</td>
<td>IFCWindowStyle</td>
<td></td>
</tr>
<tr>
<td>transport</td>
<td>IFCTransportElement</td>
<td>IFCRampFlightType</td>
<td></td>
</tr>
<tr>
<td>buildingElementProxy</td>
<td>IFCBuildingElementProxy</td>
<td>IFCBuildingElementProxyType</td>
<td></td>
</tr>
<tr>
<td>ifcMechanicalFastener</td>
<td>IFCMechanicalFastener</td>
<td>IFCMechanicalFastenerType</td>
<td></td>
</tr>
<tr>
<td>ifcFastener</td>
<td>IFCFastener</td>
<td>IFCFastenerType</td>
<td></td>
</tr>
<tr>
<td>ifcExtruded</td>
<td>IFCBuildingElementProxy</td>
<td>IFCBuildingElementProxyType</td>
<td></td>
</tr>
<tr>
<td>ifcBeamExtruded</td>
<td>IFCBeam</td>
<td>IFCBeamType</td>
<td></td>
</tr>
<tr>
<td>ifcColumnExtruded</td>
<td>IFCColumn</td>
<td>IFCColumnType</td>
<td></td>
</tr>
<tr>
<td>ifcDiscreteAccessoryExtruded</td>
<td>IFCDiscreteAccessory</td>
<td>IFCDiscreteAccessoryType</td>
<td></td>
</tr>
</tbody>
</table>
## LibPart (By UnId)

<table>
<thead>
<tr>
<th>ARCHICAD</th>
<th>IFCObjectType</th>
<th>IFCTypeObjectPredefinedType</th>
</tr>
</thead>
<tbody>
<tr>
<td>ifcFootingExtruded</td>
<td>IFCFooting</td>
<td>IFCFlowTreatmentDeviceType</td>
</tr>
<tr>
<td>ifcOpeningExtruded</td>
<td>IFCOpeningElement</td>
<td>IFCMemberType</td>
</tr>
</tbody>
</table>

## MEP (By Tool)

<table>
<thead>
<tr>
<th>ARCHICAD</th>
<th>IFCObjectType</th>
<th>IFCTypeObjectPredefinedType</th>
</tr>
</thead>
<tbody>
<tr>
<td>CableCarrierBend</td>
<td>IFCCableCarrierFitting</td>
<td>BEND</td>
</tr>
<tr>
<td>CableCarrierRigidSegment</td>
<td>IFCCableCarrierSegment</td>
<td>NOTDEFINED</td>
</tr>
<tr>
<td>CableCarrierTee</td>
<td>IFCCableCarrierFitting</td>
<td>TEE</td>
</tr>
<tr>
<td>CableCarrierTransition</td>
<td>IFCCableCarrierFitting</td>
<td>REDUCER</td>
</tr>
<tr>
<td>CableCarrierWye</td>
<td>IFCCableCarrierFitting</td>
<td>TEE</td>
</tr>
<tr>
<td>DuctBend</td>
<td>IFCDuctFitting</td>
<td>BEND</td>
</tr>
<tr>
<td>DuctEndCap</td>
<td>IFCDuctFitting</td>
<td>EXIT or ENTRY</td>
</tr>
<tr>
<td>DuctFlexibleSegment</td>
<td>IFCDuctSegment</td>
<td>FLEXIBLESEGMENT</td>
</tr>
<tr>
<td>DuctObstruction</td>
<td>IFCDuctFitting</td>
<td>OBSTRUCTION</td>
</tr>
<tr>
<td>DuctOffset</td>
<td>IFCDuctFitting</td>
<td>TRANSITION</td>
</tr>
<tr>
<td>DuctRigidSegment</td>
<td>IFCDuctSegment</td>
<td>RIGIDSEGMENT</td>
</tr>
<tr>
<td>DuctTakeOff</td>
<td>IFCDuctFitting</td>
<td>JUNCTION</td>
</tr>
<tr>
<td>DuctTee</td>
<td>IFCDuctFitting</td>
<td>JUNCTION</td>
</tr>
<tr>
<td>DuctTransition</td>
<td>IFCDuctFitting</td>
<td>TRANSITION</td>
</tr>
<tr>
<td>DuctVerticalObstruction</td>
<td>IFCDuctFitting</td>
<td>OBSTRUCTION</td>
</tr>
<tr>
<td>DuctWye</td>
<td>IFCDuctFitting</td>
<td>JUNCTION</td>
</tr>
<tr>
<td>PipeBend</td>
<td>IFCPipeFitting</td>
<td>BEND</td>
</tr>
<tr>
<td>PipeCombinationWye</td>
<td>IFCPipeFitting</td>
<td>JUNCTION</td>
</tr>
<tr>
<td>PipeInlineFlowDevice</td>
<td>IFCPipeFitting</td>
<td>&lt;ifc_predefinedtype parameter&gt;</td>
</tr>
<tr>
<td>PipeRigidSegment</td>
<td>IFCPipeSegment</td>
<td>RIGIDSEGMENT</td>
</tr>
<tr>
<td>ARCHICAD</td>
<td>IFCObjectType</td>
<td>IFCTypeObject</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>PipeSanitaryTee</td>
<td>IFCPipeFitting</td>
<td>IFCPipeFittingType</td>
</tr>
<tr>
<td>PipeTakeOff</td>
<td>IFCPipeFitting</td>
<td>IFCPipeFittingType</td>
</tr>
<tr>
<td>PipeTee</td>
<td>IFCPipeFitting</td>
<td>IFCPipeFittingType</td>
</tr>
<tr>
<td>PipeTransition</td>
<td>IFCPipeFitting</td>
<td>IFCPipeFittingType</td>
</tr>
<tr>
<td>PipeWye</td>
<td>IFCPipeFitting</td>
<td>IFCPipeFittingType</td>
</tr>
</tbody>
</table>
## Data Types for Properties in IFC and ARCHICAD

<table>
<thead>
<tr>
<th>IFC Data Type</th>
<th>ARCHICAD Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single String</td>
<td>String</td>
<td>Any text or number</td>
</tr>
<tr>
<td>Single Real</td>
<td>Number</td>
<td>Any number expressed in decimals</td>
</tr>
<tr>
<td>Single Integer</td>
<td>Integer</td>
<td>A whole number</td>
</tr>
<tr>
<td>Single Boolean</td>
<td>True/False</td>
<td>A logical true or false value</td>
</tr>
<tr>
<td>List String</td>
<td>Tags List</td>
<td>A tag or series of tags.</td>
</tr>
<tr>
<td>Enumerated String</td>
<td>Option Set</td>
<td>Provides a fixed set of options. The user can choose a value from this set.</td>
</tr>
</tbody>
</table>
Index

A
ARCHICAD Survey Point 150

B
Bounding box 147
BREP 148, 184
Building Information Data Settings 174

C
Clear All Settings 161
Compatibility 127
Convert to single element 153
Coordination View 183
Coordination View (Surface Geometry) 183
Create new Layers to keep original Layer structure 118

D
Disconnected 70

E
Elements in Solid Element Operations (IFC Export) 148
Elements with junctions (IFC Export) 149
Export Building Material Properties to IFC 172
Export Component Parameters to IFC 173
Export Door-Window Parameters to IFC 173
Export Element Parameters to IFC 172
Export Zone Categories to IFC 173
Express Data Manager (EDM) path (IFC Options) 80
Extend original Layer names with suffix 118
Extruded/revolved 148

F
Filter Containment 175
Find by GlobalId 42

G
Geodetic Datum 152
Geometry Conversion (IFC Translator) 114
Geometry of Type Product 147
Global Unique Identifiers (GUID) (IFC Translator) 176
Globalld 176

I
IFC 5
  ~ Basic Terms and Definitions 186
  ~ Domain 97, 129
  ~ Element Classification 8
  ~ Element Type and Classification 5
  ~ Entity 186
  ~ File types 7
  ~ Import - Open and Merge 15
  ~ Model Filter 178
  ~ Options 80
  ~ View Definition 148
IFC Global Origin 116
IFC Global Unique Identifier attribute 176
IFC Interface language 80
IFC model units 147
IFC Site geometry (IFC Export) 150
IFC Site Location 116
IFC Site location 150
IFC Space boundaries 175
IFC View Definition 183
IfcFooting 97
IfcOpeningElement 148
IfcPile 97
Import all Site geometry 20
Import from Current Project 161

K
Keep ARCHICAD IFC ID 176
Keep hierarchy 153

L
Layer Conversion (IFC Import Options) 117
List visible model elements only 41
LoadBearing 97

M
Map IFC Properties for Export 156
Map IFC Types for Export 132
Map Projection 152
Material and Surface Conversion (IFC Import/Export Options) 121
Model Filter for Import 178
Model View Definition 125, 183

P
Place all elements on a single new Layer 117
Position (Classification) 9

R
Referencing Map 152

Renovation Status (IFC Translator) 106

S
Save Library Parts Generated During Import To 80
Show Model Filter on import 97
Slabs with slanted edge(s) (IFC Export) 149
Space containment 174
Split Complex Building Elements into parts 153
Structural Function 9
Surface Geometry (IFC Export) 148
Survey Point Element 151

U
Update with IFC Model 35
Use existing ARCHICAD Layers 118
USERDEFINED 137